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6.1 Gerätebeschreibung . . . . . . . . . . . . . . . . . . . . . 18

6.1.1 Das Grundgerät . . . . . . . . . . . . . . . . . . . 18

6.1.2 Option Datenlogger . . . . . . . . . . . . . . . . . 18

6.1.3 Option Flutung . . . . . . . . . . . . . . . . . . . . 18

6.2 Sicherheitshinweise . . . . . . . . . . . . . . . . . . . . . 18

6.3 Entsorgungshinweise . . . . . . . . . . . . . . . . . . . . 19

6.4 Aufstellhinweise - Grundgerät . . . . . . . . . . . . . . . . 19

6.5 Netzanschluss . . . . . . . . . . . . . . . . . . . . . . . . 19

6.6 Aufstellhinweise für die Flutungsoption . . . . . . . . . . . 19

6.6.1 Türanschlag wechseln . . . . . . . . . . . . . . . . 20

6.7 USB-Stick . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

6.8 Bestücken der Anlage mit Proben . . . . . . . . . . . . . . 24

6.8.1 Normalbetrieb . . . . . . . . . . . . . . . . . . . . 24

6.8.2 Flutungsbetrieb . . . . . . . . . . . . . . . . . . . 24
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9.7.4 Kühlung . . . . . . . . . . . . . . . . . . . . . . . . 41

9.7.5 Zeit . . . . . . . . . . . . . . . . . . . . . . . . . . 41

9.7.6 Fluten (Option) . . . . . . . . . . . . . . . . . . . . 43
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1 Einführung

Der Slab-Test Frostprüfschrank ermöglicht die Befrostung der Proben
nach dem Temperatur-Zyklus des Platten-Prüfverfahrens nach der

• prEN 12390-9 (Prüfung von Festbeton - Teil 9: Frost- und Frost-
Tausalzwiderstand; Abwitterung; prEN 12390-9:2002 )

• DIN EN 1340 (Bordsteine aus Beton - Anforderungen und Prüfverfahren;
EN 1340:2003)

• DIN EN 1339,(Platten aus Beton - Anforderungen und Prüfverfahren;
EN 1339:2003 ) und

• DIN EN 1341,(Platten aus Naturstein für Außenbereiche - Anfor-
derungen und Prüfverfahren; 1341:2001)

Mit der Zusatzoption Flutung sind außerdem folgende Tests möglich:

• DIN EN 12371: Oktober 2001, Prüfverfahren für Naturstein Bestim-
mung des Frostwiderstandes

• DIN EN 1348 Norm-Entwurf , 2006-09 Mörtel und Klebstoffe für
Fliesen und Platten - Bestimmung der Haftfestigkeit zementhaltiger
Mörtel für innen und außen; Deutsche Fassung prEN 1348:2006

• DIN EN 1367-1, Ausgabe:2000-01 Prüfverfahren für thermische
Eigenschaften und Verwitterungsbestı̈ändigkeit von Gesteinskörnungen
- Teil 1: Bestimmung des Widerstandes gegen Frost-Tau-Wechsel;
Deutsche Fassung EN 1367-1:1999

2 Der Platten-Test, Slab-Test oder Borøs-Test

Der Slabtest wird als Frost-Tautest in den Normen EN 1339, 1340 1341
und 12390-9 definiert. Leider unterscheiden sich die Normen in Details.
Im Folgenden ist sinngemäß die Norm:

EN1339:2003(D) Anhang D (normativ): Bestimmung der Wi-
derstandsfähigkeit gegen Frost-Tau-Wechsel mit Tausalz

wiedergegeben. Wo die Norm 12390-9 davon abweicht ist dies in kursi-
ven Buchstaben angegeben. Bitte beachten Sie die Orginalnormen. Die
folgenden Angaben sind sinngemäß wiedergegeben und nicht vollständig.
Eine Haftung für die Richtigkeit der Angaben wird nicht übernommen.

2.1 Prinzip

Der Probekörper wird konditioniert und dann bei mit 3%iger NaCl-Lösung
(oder demineralisiertem Wasser) bedeckter Oberfläche 28 (56) Frost-
Tau- Wechseln ausgesetzt. Das abgesplitterte Material wird gesammelt
und gewogen und das Ergebnis in kg/m2 angegeben.

2.2 Probekörper

Die Fläche der Oberseite des Probekörpers muss über 7500 mm2, je-
doch unter 25000 mm2 betragen (Platten 150x150x50mm). Sie ist als
Prüffläche zu verwenden. Die Dicke des Probekörpers (beträgt 50mm)
darf 103 mm nicht überschreiten (geprüft wird immer die gesägte Fläche).
Wenn der Probekörper, um diese Anforderung zu erfüllen, aus einer
Platte heraus geschnitten werden muss, muss dies durch Sägen aus
einer mindestens 20 Tage alten Platte erfolgen.
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2.3 Materialien

2.3.1 Trinkwasser.

2.3.2 Tausalzlösung

bestehend aus 97 Masse-% Trinkwasser und 3 Masse-% NaCl (oder
demineralisiertes Wasser).

2.3.3 Klebstoff

zum Festkleben der Gummischicht am Betonprobekörper. Der Klebstoff
muss in der jeweiligen Umgebung beständig sein.Anmerkung

Ein Kontaktkleber hat sich als geeignet erwiesen.

2.3.4 Silikon-Dichtungsmasse

oder andere Dichtungsmasse als Abdichtung zwischen dem Probekörper
und der Gummischicht und zum Verfüllen einer möglichen Fase am Um-
fang des Probekörpers.

2.4 Geräte

2.4.1 Diamantsäge

zum Schneiden von Betonprobekörpern.

2.4.2 Klimakammer

mit einer Temperatur von (20±2)◦C und einer relativen Luftfeuchte von
(65±10)% ((65±5)%). In der Klimakammer muss die Verdunstung von
einer freien Wasseroberfläche (200±100) g/m2 in (240±5) min ((45±15)
g/m2h) betragen. Die Verdunstung muss mittels einer Schale mit einer
Höhe von etwa 40 mm und einer Querschnittsfläche von (22500±2500)
mm2 gemessen werden. Die Schale muss bis (10±1) mm unter den
Rand gefüllt sein.

2.4.3 Gummischicht

(3,0±0,5) mm dick, die beständig gegen die verwendete Salzlösung und
bis zu einer Temperatur von -20◦C (-27◦C) ausreichend elastisch ist.

2.4.4 Wärmedämmung aus Polystyren

(20±1) mm dick, mit einer Wärmeleitfähigkeit zwischen 0,035 W/mK und
0,04 W/mK oder eine entsprechende andere Wärmedämmung. Polysty-
rol, (20±1) mm dick, mit einer Dichte von 18±2) kg/m3, oder eine andere
Wärmedämmung mit mindestens gleichwertigen Eigenschaften

2.4.5 Polyethylenfolie

0,1 mm bis 0,2 mm dick.

2.4.6 Frostschrank

mit zeitgesteuertem Kühl- und Heizsystem, dessen Leistungsvermögen
und Luftumwälzung die Einhaltung der Zeit-Temperatur-Kurve von Bild
3 bewirken.
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2.4.7 Thermoelemente

oder ein gleichwertiges anderes Temperaturmessgerät zum Messen der
Temperatur in der Tausalzlösung auf der Prüffläche mit einer Messunsi-
cherheit von ±0,5◦C.

2.4.8 Gefäß zum Sammeln des abgewitterten Materials

Das Gefäß muss bis zu einer Temperatur von 120◦C verwendbar und
gegen Natriumchlorid beständig sein.

2.4.9 Papierfilter

zum Auffangen des abgewitterten Materials.

2.4.10 Pinsel

zum Abbürsten des abgewitterten Materials: 20mm bis 30mm breiter
Malerpinsel, dessen Borsten auf eine Länge von 20mm abgeschnitten
sind.

2.4.11 Spritzflasche

mit Trinkwasser zum Abspülen des abgewitterten Materials und Auswa-
schen von Salz vom abgewitterten Material.

2.4.12 Trockenschrank

geeignet für eine Temperatur von (105±5)◦C.

2.4.13 Waage

mit einer Messunsicherheit von ±0,05g.

2.4.14 Noniusschieblehre

mit einer Messunsicherheit von 0,1mm.

2.5 Vorbereitung von Probekörpern

Von Proben, die mindestens 28 Tage und, ausgenommen bei der Ab-
nahmeprüfung, höchstens 35 Tage alt sind, sind Grate und loses Materi-
al zu entfernen; die Proben sind in der Klimakammer (168±5) h bei einer
Temperatur von (20±2)◦C, einer relativen Luftfeuchte von (65±10)% und
einer Verdunstungsrate von (200±100)g/m2 in den ersten (240±5)min,
gemessen nach Absatz 2.4.2, zu lagern. Der Abstand der Proben unter-
einander muss mindestens 50 mm betragen. Während dieser Zeit wird
die Gummischicht auf alle Flächen des Probekörpers, mit Ausnahme
der Prüffläche, geklebt und bleibt während der Prüfung geklebt. Zum
Verfüllen der Fase um den Probekörper und als Abdichtung am Rand
der Prüffläche in der Ecke zwischen dem Beton und der Gummischicht
zum Schutz gegen das Eindringen von Wasser zwischen Probekörper
und Gummi ist Silikon-Dichtungsmasse oder andere Dichtungsmasse
zu verwenden. Der Rand der Gummischicht muss (20±2) mm über die
Prüffläche ragen.Anmerkung

Der Klebstoff wird gewöhnlich auf den Betonflächen und Gummiflächen
verteilt. Als geeignet hat sich die in Bild 1 dargestellte Art der Verklebung
der Gummischicht erwiesen.



2 Der Platten-Test, Slab-Test oder Borøs-Test 9

Abbildung 1: Beispiel für den Querschnitt eines Probekörpers mit Gum-
mischicht und dem Strang der Dichtungsmasse (rechts) und einer Drauf-
sicht vom Probekörper (links)

Die Größe der Prüffläche 1 muss aus dem Mittelwert von drei Messun-
gen ihrer Länge und Breite, auf Millimeter gerundet, ermittelt werden.
Nach der Lagerung im Klimaschrank ist Trinkwasser mit einer Tempe-
ratur von (20±2)◦C bis zu einer Höhe von (5±2) mm auf die Prüffläche
zu gießen. Diese muss (72±2) h bei einer Temperatur von (20±2)◦C so
bleiben und kann zur Bewertung der Wirksamkeit der Dichtung zwischen
Probekörper und Gummischicht dienen.

Vor dem Frost-Tau-Wechsel müssen alle Flächen des Probekörpers, mit
Ausnahme der Prüffläche, wärmegedämmt werden. Dies kann während
der Nachbehandlung durchgeführt werden. Die Dämmung muss Bild 2
entsprechen.

15min bis 30min vor dem Einbringendes Probekörpers in den Kälteschrank
muss das Wasser auf der Prüffläche durch eine (5±2)mm dicke Schicht,
gemessen vom oberen Rand des Probekörpers, aus 3% NaCl in Trink-
wasser ersetzt werden. Diese muss durch Anbringung einer horizonta-
len Polyethylenfolie, wie in Bild 2 dargestellt, gegen Verdunstung geschätzt
werden. Die Polyethylenfolie muss während der Prüfung möglichst glatt
bleiben und darf nicht mit der Tausalzlösung in Berührung kommen.

2.6 Herstellung der Probekörper (EN 12390-9)

Für die Prüfung werden 4 Probekörper, die aus 4 Würfeln entnommen
werden, benötigt

Während der ersten Tage nach dem Herstellen sind die Würfel in den
Formen zu lagern und durch Abdecken mit einer Polyethylenfolie gegen
Austrocknen zu schätzen. Die Lufttemperatur beträgt (20±2 ◦ C2).

Nach (24±2) h sind die Würfel zu entformen und in einem mit Leitungs-
wasser mit einer Temperatur von (20±2)◦C gefüllten Wasserbad zu la-
gern.

Im Alter von 7 Tagen werden die Würfel aus dem Wasserbad entnom-
men und in die Klimakammer gestellt, wo sie bis zum Beginn der Prüfung
gelagert werden.
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Abbildung 2: Prinzipieller Aufbau für die Frost-Tausalz-Prüfung

Nach 21 Tagen ist ein (50±2) mm dicker Probekörper aus jedem Würfel
rechtwinklig zur Herstellungsoberfläche zu sägen, so dass die geschnit-
tene Fläche als Prüffläche im Zentrum des Würfels liegt.

Unmittelbar nach dem Sägen werden die Probekörper mit Leitungswas-
ser abgewaschen, das überschüssige Wasser mit einem feuchten Schwamm
abgetupft und die Probekörper anschließend ohne Verzögerung in die
Klimakammer zurückgebracht. Die Probekörper sind mit der Prüffläche
nach oben zeigend so aus zurichten, dass dazwischen ein Zwischen-
raum von mindestens 50mm entsteht. Alle Abmessungen der Probekörper
sind mit einem Messschieber mit einer Messunsicherheit von ±0,5mm
zu bestimmen. Die Abweichung der Dicke eines Probekörpers darf 2mm
nicht überschreiten.

Wenn der Beton (2±1) Tage alt ist, ist eine Gummischicht auf allen
Oberflächen jedes Probekörpers mit Ausnahme der Prüffläche zu kle-
ben. Ein Klebstoffstreifen oder ein Silikonstreifen ist auf die Prüffläche
zwischen Beton und Gummischicht anzubringen. Der Rand der Gummi-
schicht muss (20±1) mm über die Prüfoberfläche reichen.

Wenn der Beton 28 Tage alt ist, wird eine 3mm dicke Schicht aus demi-
neralisiertem Wasser mit einer Temperatur von (20±2)◦C auf die Prüfoberfläche
aufgebracht. Diese Wiederbefeuchtung wird (72±2) h bei (20±2)◦C fort-
gesetzt. Während dieses Zeitraums muss die Schichtdicke stets un-
gefähr 3mm betragen.

Anmerkung

Bei Probekörpern mit einer Prüffläche von 150x150mm werden für eine
rund 3mm dicke Schicht 67 ml demineralisiertes Wasser benötigt.

Vor der Prüfung des Betons werden alle Oberflächen der Probekörper
mit Ausnahme der Prüfoberfläche mit Polystyrol Schaumstoff mit einer
Dicke von (20±1) mm als Wärmedämmung entsprechend der Prüfanordnung
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Obergrenze Untergrenze
Zeit (Stunden) Temperatur (◦C) Zeit (Stunden) Temperatur(◦C)

0 24 0 16
5 -2 3 -4

12 -14 12 -20
16 -16 16 -20
18 0 20 0
22 24 24 16

Tabelle 1: Koordinaten der Knickpunkte nach EN 1339

versehen. Es darf auch ein anderes Material oder eine andere Dicke ver-
wendet werden, vorausgesetzt, dass die Wärmedämmung vergleichbar
ist.

Die Prüfung beginnt, wenn die Probekörper 31 Tage alt sind. Frühestens
15 min bevor die Probekörper in die Frosttruhe gestellt werden, ist das
deminarilisierte Wasser auf jeder Prüfoberfläche durch 67 ml Prüfflüssigkeit
zu ersetzen, um eine mittlere Tiefe von 3mm zu erzielen. Die Prüfflüssigkeit
muss eine Temperatur von (20±2)◦C aufweisen.

Die Prüfflüssigkeit ist, wie in Bild 2 dargestellt, durch Aufbringen einer
ebenen horizontalen Polyethylenfolie gegen Verdunsten zu schützen.
Die Polyethylenfolie muss während der gesamten Prüfung eben bleiben.

2.7 Durchführung

Die Probekörper sind so in den Frostschrank einzubringen, dass die
Prüffläche höchstens 3mm/m in jeder Richtung von der Horizontalen
abweicht, und sie sind Frost-Tau-Wechseln aus zusetzen. Während der
Prüfung muss die Zeit-Temperatur-Kurve in der Tausalzlösung in der Mit-
te der Oberfläche aller Probekörper in dem schraffierten Bereich von
Bild 3 liegen. Darüber hinaus muss die Temperatur während jedes Wech-
sels mindestens 7h, jedoch höchstens 9h über 0◦C liegen.Hinweis des Herstellers!

Der Temperaturverlauf ist stark von der Beladung der Kammer, der Pro-
benform und der Luftumwälzung abhängig. Der Sollzyklus beim Slab-
tester muss deshalb daran angepasst werden!

Die Temperatur in der Tausalzlösung in der Mitte der Prüffläche ist konti-
nuierlich mindestens für einen Probekörper aufzuzeichnen, der in einer
repräsentativen Position im Frostschrank angeordnet ist. Die Lufttempe-
ratur im Frostschrank ist während der Prüfung aufzuzeichnen. Die Zeit
für den ersten Prüfzyklus für einen Probekörper beginnt (0±30)min nach
seinem Einbringen in den Kälteschrank. Wenn ein Zyklus unterbrochen
werden muss, muss der Probekörper in gefrorenem Zustand zwischen
-16◦C und -20◦C verbleiben. Wenn diese Unterbrechung länger als 3
Tage andauert, muss die Prüfung abgebrochen werden.

Zeit-Temperatur-Zyklus In Tabelle 2 sind die Knickpunkte angegeben,
die den schraffierten Bereich in Bild 3 vorgeben.

Um den korrekten Temperatur-Zyklus für alle Probekörper zu erreichen,
ist eine gute Luftzirkulation im Frostschrank sicherzustellen. Wenn nur
einige Probekörper zu prüfen sind, sind die freien Stellen im Frostschrank
mit Blindprobekörpern auszufüllen, es sei denn, es ist erwiesen, dass
der korrekte Temperaturzyklus auch ohne sie erreicht wird.
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Abbildung 3: Zeit - Temperatur-Zyklus

Obergrenze Untergrenze
Zeit(Stunden) Temperatur(◦C) Zeit(Stunden) Temperatur(◦C)

0 24 0 16
5 -3 3 -5
12 -15 12 -22
16 -18 16 -22
18 -1 22 -1
22 24 24 16

Tabelle 2: Koordinaten der Knickpunkte nach EN 12390-9
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Je nach Bedarf ist nach 7 bzw. 14 Frost-Tau-Wechseln in der Auftaupe-
riode weitere Lösung mit 3% Natriumchlorid in Trinkwasser zuzufügen,
um eine Schicht von (5±2)mm auf der Oberfläche der Proben beizube-
halten.

Nach 28 Frost-Tau-Wechseln muss für jeden Probekörper folgendes Ver-
fahren durchgeführt werden:

a) Es ist das Material, das von der Prüffläche abgewittert ist, durch
Abspülen mit der Spritzflasche in den Behälter und Abbürsten in den
Behälter zu sammeln , bis die Fläche frei von abgewittertem Material ist.

b) Die Flüssigkeit und das abgewitterte Material im Gefäß sind vorsich-
tig durch ein Filterpapier zu filtrieren. Um alle Rückstände von Natrium-
chlorid zu entfernen, wird das im Filterpapier gesammelte Material mit
mindestens 1l Trinkwasser gespült. Das Filterpapier und das gesammel-
te Material werden mindestens 24h bei (105±5)◦C getrocknet. Die Tro-
ckenmasse des abgewitterten Materials ist unter Berücksichtigung des
Filterpapiers auf±0,2g zu bestimmen.

Nach 7, 14, 28, 42, 56 Frost-Tau-Wechseln ist während der Tauphase
zwischen 20 h und 24 h bei jedem Probekörper wie folgt zu verfahren:

Das von der Oberfläche abgewitterte Material ist in einem Behälter auf-
zufangen. Die Oberfläche ist mit einer Sprühflasche zu spülen und ab-
zubürsten, um das abgewitterte Material zu entfernen.

Es ist neue Prüfflüssigkeit auf die Oberfläche aufzubringen. Für eine
Prüffläche mit den Maßen 150 x 150 mm wird 67 ml Prüfflüssigkeit
benötigt.

Der Probekörper ist wieder in die Frosttruhe zu stellen.

Die Flüssigkeit im Behälter ist vorsichtig ab zugießen. [Es wird emp-
fohlen die Flüssigkeit durch einen geeigneten Papierfilter zu gießen,
insbesondere wenn geringe Mengen an abgewitterten Material vorhan-
den sind.] Der Behälter [und Filter, sofern verwendet] ist bei 110±10)
◦C bis zur Massekonstanz zu trocknen und anschließend mit der Waa-
ge zu wägen. Die Masse des trockenen, abgewitterten Materials ist zu
bestimmen, um die Masse des Behälters [und des Filters] zu korrigie-
ren. Die Masse des abgewitterten Materials Mn beträgt dann: Mn =
Mn −Mbrutto +Mfilter. Der Wert ist auf 1g gerundet anzugeben.

2.8 Berechnung der Prüfergebnisse

Der Massenverlust je Flächeneinheit des Probekörpers (L) in Kilogramm
je Quadratmeter ist nach Gleichung

L = M/A

zu berechnen.

Dabei ist

M Masse der Gesamtmenge an abgewitterten Material nach 28 Frost-
Tau-Wechseln in kg;

A Die Flache der Prüffläche, in m2.

Für jeden Messtermin und jeden Probekörper ist die Gesamtmenge an
abgewitterten Material Sn nach n Frost-Tauwechseln in Kilogramm je
Quadratmeter nach folgender Gleichung zu berechnen:

Sn = 10Mn/An
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Dabei ist:

Sn die Masse des Abgewitterten Materials bezogen auf die Prüffläche
nach dem n-ten Frost-Tau-Wechsel, in kg/m2Einfügen in die Formel in g ?

Mn die Gesamtmasse des abgewitterten Materials nach n Frost-Tau-
Wechseln, die wie s.o. bestimmt wird, auf 1g gerundetEinsetzen in die Formel in

cm2 ?
A die Prüfoberfläche , die aus den Längenmessungen mit dem Mess-
schieber ermittelt wird, auf 1 cm2 gerundet.

2.9 Prüfbericht

Der Prüfbericht muss folgende Angaben enthalten:

1. den Masseverlust je Flächeneinheit des Probekörpers (L), in kg/m2

2. die Masse der Gesamtmenge an abgewitterten Material nach 28
Frost-Tau-Wechseln, in mg.

3. die Fläche der Prüffläche, in mm2

Der Prüfbericht muss mindestens die folgenden Angaben enthalten:

• Verweis auf die Norm

• Herkunft und Kennzeichnung der Probekörper;

• Art des Betons;

• Zusammensetzung der Prüfflüssigkeit;

• Gesamtmenge des abgewitterten Materials für jeden Probekörper
als auch den Mittelwert nach 7, 14, 28, 42, und 56 Frost-Tau-
Wechseln in Kilogramm je Quadratmeter auf 0,02 kg/m2 gerundet:

• Augenscheinprüfung (Risse, Abwitterung von Zuschlagpartikeln,
Verlust von Prüfflüssigkeit) vor Beginn der Prüfung und nach 7,
14, 28, 42 und 56 Frost-Tau-Wechseln;

• alle Abweichungen vom Referenz-Prüfverfahren;

• Freigestellt: Zusammensetzung des Betons;

3 Test von Naturstein nach EN 12371

3.1 Die Probekörper

Die Probekörper haben die Gestalt rechtwinkliger Prismen mit den Ma-
ßen 50mm ∗ 50mm ∗ 300mm3. Die Längsachse der Probe muss parallel
zu den Anisotropieebenen verlaufen. Um sicherzustellen, dass die ver-
schiedenen Elastizitätsmodulmessungen vor und nach den Frost-Tau-
Wechseln an denselben Punkten der Probe durchgeführt werden, wer-
den dauerhafte Markierungen, in Form von Punkten, auf den entspre-
chenden Flächen der Messprobe angebracht. Eine dauerhafte Linie wird
an den Achsen der beiden Auflager gezogen, auf denen die Proben
während der Bestimmung der dynamischen Elastizitätsmodule ange-
bracht werden.
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3.2 Aufnahme der Kerntemperatur

Eine Probe jedes Probensatzes muss mit einer Einrichtung (z. B. einem
Thermoelement) ausgestattet werden, um die Temperatur der Probe des
Frost-Tau-Wechsels zu messen. Die Messvorrichtung ist in einem Loch
anzubringen, das parallel zu der Längsachse der Messprobe gebohrt
wurde. Der Durchmesser des Lochs muss zum Durchmesser der Mess-
probe passen. Das Zentrum des Lochs muss gleich weit von den Kanten
der Messprobe entfernt sein, bis zu einer Minimaltiefe von 50 mm von
der Spitze. Wenn Würfel verwendet werden, muss das Loch (25±5) mm
tief sein. Die Messvorrichtung ist im Loch anzubringen, das dann un-
gefüllt zu belassen ist.

3.3 Durchführung der Prüfung

3.3.1 Anordnung der Probe im Kälteschrank

Die Proben sind entweder mit der Längsachse vertikal oder horizontal so
in den Behälter zu setzen, dass sie sich nicht gegenseitig oder die Sei-
ten des Behälters berühren. Sie werden mindestens 10 mm voneinander
entfernt und mindestens 20 mm von den Behälterseiten entfernt ange-
ordnet. Die Referenzprobe mit der Temperaturmess- einrichtung wird in
die Mitte der zu prüfenden Proben gelegt. Nach jeweils 14 Zyklen (oder
weniger, wenn ausreichend) werden die Proben um 180◦ um die hori-
zontale Achse gedreht.

3.4 Beschreibung der Frost-Tau-Wechsel

Jeder Wechsel besteht aus einer sechsstündigen Gefrierperiode an Luft,
gefolgt von einer sechsstündigen Tauperiode, während deren die Pro-
ben in Wasser getaucht sind. Die Wechsel sind bis zum Versagen der
Proben oder bis zur vorgegebenen Zyklenzahl zu wiederholen. Während
des Wechsels müssen die Temperaturänderungen in der Mitte der beob-
achteten Probe innerhalb des vorgeschriebenen Bereichs bleiben. Der
Bereich der erlaubten Temperatur ist das Ergebnis der verschiedenen
Kühl-, Frost- und Tauraten, die mit der scheinbaren Dichte, der Porosität
und der Wasserabsorption des geprüften Gesteins zusammenhängen.
Jeder Wechsel sieht wie folgt aus:

Temperatur im Zentrum der ge-
messenen Probe

Zeit

Beginn des Wechsels 5◦C ≤ T ≤ +20◦C t0
Stadium 1 −8◦C ≤ T ≤ 0◦C t0 + 2.0h
Stadium 2 −12◦C ≤ T ≤ −8◦C t0 + 6.0h
Stadium 3 vollständiges Eintauchen t0 + 6.5h
Stadium 4 5◦C ≤ T ≤ +20◦C t0 + 9.0h
Stadium 5 5◦C ≤ T ≤ +20◦C t0 + 12.0h

Wenn die Temperatur des Gesteins nicht innerhalb des Bereiches bleibt,
muss der Kälteschrank so eingestellt werden, dass die Temperatur in-
nerhalb des Bereiches bleibt. Jede Abweichung muss im Prüfbericht no-
tiert werden. Wenn die Prüfung manuell durchgeführt wird, kann Sta-
dium 5 bis auf t0 + 24, 0h ausgedehnt werden. Zur Identitätsprüfung
können verschiedene Zyklenzahlen und Bedingungen verwendet wer-
den, wenn vom Kunden spezielle Anforderungen gestellt werden. Jede
Änderung der Prüfbedingungen ist im Prüfbericht zu notieren. ANMER-
KUNG Es ist wichtig, dass die Prüfkörper im Wasser aufgetaut wer-
den, da dies sicherstellt, dass sie zu Beginn der nächsten Frostperi-
ode wassergetränkt sind. Wenn die Prüfung aus anderen Gründen als
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zur Prüfung unterbrochen werden muss, sind die Prüfkörper jederzeit in
Wasser (20± 5)◦C zu tauchen.

4 Test von Gesteinskörnung nach DIN EN 1367-1,

4.1 Prinzip

Messproben aus Gesteinskörnungen einer Größe, die bei Atmosphärendruck
mit Wasser getränkt wurden, werden 10 Frost-Tau-Wechseln ausgesetzt.
Dies beinhaltet das Abkühlen auf −17.5◦C unter Wasser und das an-
schließende Auftauen im Wasserbad bei 20◦C. Nach Abschluss der Frost-
Tau-Wechsel werden die Gesteinskörnungen auf Veränderungen (Riss-
bildung, Absplitterung und gegebenenfalls Festigkeitsveränderungen) un-
tersucht. Das Prüfverfahren besteht aus dem Tränken bei Atmosphärendruck
und der Lagerung im Wasser zur Wasseraufnahme und einer Frostbe-
anspruchung unter Wasser.

4.2 Notwendiger Kälteschrank

Es muss ein Kälteschrank mit Luftumwälzung vorhanden sein. Ein ma-
nuelles Verfahren zur Regelung darf verwendet werden, wenn der kor-
rekte Temperaturverlauf, erreicht wird. Im Schiedsfall muss die automa-
tische Regelung verwendet werden.

Es müssen drei Einzelmessproben verwendet werden. Die Einzelmess-
proben müssen in Übereinstimmung mit EN 932-2 durch Probeneinen-
gung aus Lieferkörnungen einer Größe gewonnen werden, aus denen
Überkorn- und Unterkornanteile entfernt wurden.

4.3 Durchführung

4.3.1 Wassertränkung

Die vorbereiteten Einzelmessproben müssen bei Atmosphärendruck für
24 Stunden in den in festgelegten Dosen bei 20◦C in destilliertem oder
entmineralisiertem Wasser gelagert werden, wobei das Wasser die Ein-
zelmessproben für die gesamte Zeit von 24 h mindestens 10 mm überdeckt.

4.3.2 Frostbeanspruchung unter Wasser

Es ist zu kontrollieren, ob der Wasserstand in jeder Dose noch mindes-
tens 10 mm über der Einzelmessprobe liegt, dann sind die Dosen mit
den Deckeln zu verschließen. Die verschlossenen Dosen mit den Einzel-
messproben sind in den Kälteschrank zu stellen, wobei sicherzustellen
ist, dass der Abstand zwischen den Dosen und den Seitenwänden des
Kälteschrankes nicht geringer als 50 mm ist und die Dosen sich nicht
berühren, so dass die Wärme so gleichmäßig wie möglich von allen Sei-
ten abgeführt wird. Unter Verwendung der Temperatur in der Mitte einer
geschlossenen Dose, die im Zentrum der gekühlten Fläche steht, als
Referenzmesspunkt, ist der Kälteschrank so zu regeln, dass die Tempe-
ratur der Abkühlkurve nach folgender Tabelle erfolgt.

Die Proben im Kälteschrank müssen anschließend 10 Frost- Tau-Wechseln
wie folgt ausgesetzt werden:

• Die Temperatur ist innerhalb von 150±30 min) von 20◦C auf 0 ◦C
abzusenken und dann 210± 30 min bei 0◦C zu halten.
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• Die Temperatur ist innerhalb von 180±30 min von 0 auf -17,5±2,5
◦C abzusenken und dann mindestens 240 min bei -17,5±2,5 ◦C zu
halten. Anmerkung: Falls es erforderlich ist, die Prüfung während
der Befrostung zu unterbrechen, oder wenn mit Handregelung ge-
arbeitet wird, zum Beispiel an Wochenenden, sollten die Dosen bei
-17,5±2,5 ◦C gehalten werden. Eine Gesamtunterbrechung von
72 h ist möglich.

• In keiner Phase darf die Lufttemperatur unter -22◦C fallen.

• Nach Abschluss jeder Befrostung müssen die Dosen durch Ein-
tauchen in Wasser bei etwa 20◦C aufgetaut werden. Das Auftauen
wird als abgeschlossen betrachtet, wenn TR eine Temperatur von
20±3 ◦C erreicht hat.

• Nach Abschluss jeder Tauphase sind die Dosen höchstens 10 h
bei 20±3◦C im Wasser zu lagern. Jeder Frost-Tau-Wechsel muss
innerhalb 24 h abgeschlossen sein. Nach Abschluss des zehnten
Wechsels ist der Inhalt jeder Dose auf ein Analysensieb mit der
halben Lochweite der unteren Prüfkorngröße der Einzelmesspro-
be zu schütten (z. B. bei Korngrößen von 8 mm bis 16 mm, auf
ein Analysensieb mit einer Lochweite von 4 mm). Die Einzelmess-
probe ist auf dem vorgeschriebenen Sieb von Hand zu waschen
und zu sieben. Der Siebrückstand ist bei 110±5◦C bis zur Mas-
senkonstanz zu trocknen, auf Umgebungstemperatur abzukühlen
und unmittelbar danach zu wägen.

5 Test von Fließenkleber nach DIN EN 1348

5.1 Probekörper

Haftfestigkeit nach Frost-Tauwechsel-Lagerung Die Prüfkörper sind wie
üblich herzustellen. Zusätzlich muss eine Mörtelschicht von ungefähr
1 mm Dicke mit einer Glättkelle auf die Rückseite der Fliese des Typs
V1 vor dem Anordnen aufgetragen werden. Die Prüfkörper sind für 7
Tage bei Normalklima zu konditionieren und anschließend für 21 Tage
in Wasser zu lagern, bevor 25 Frost-Tauwechsel-Zyklen durchgeführt
werden.

5.2 Frost- Tauwechsel

Für jeden Frost-Tauwechsel gilt:

• Die Prüfkörper sind aus dem Wasser zu entnehmen und die Tem-
peratur ist innerhalb von 2 h±20 min auf (15±3)◦C abzusenken.

• Die Prüfkörper sind für 2 h±20 min bei ( 15±3)◦C zu lagern.

• Die Prüfkörper sind in Wasser mit einer Temperatur von (20±3)◦C
einzutauchen, die Temperatur ist auf (15±3)◦C zu erhöhen und
diese Temperatur ist für 2 h±20 min zu halten. Dieser Zyklus ist 25
Mal zu wiederholen. Nach dem letzten Zyklus sind die Prüfkörper
aus dem Wasser zu entnehmen, mit einem Tuch abzutrocknen und
die Zuganker-Platten auf die Fliesen zu kleben. Die Prüfkörper
sind für weitere 24 h bei Normalklima zu konditionieren und die
Haftzugfestigkeit ist zu bestimmen.
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6 Der Slabtester, Installation und Bedienung

6.1 Gerätebeschreibung

6.1.1 Das Grundgerät

Der Schleibinger Slabtester ist außen und innen aus Edelstahl gefertigt.
Die Bedienung erfolgt über den eingebauten Regler und Funktionstas-
ten. Der Werk seitig definierte Temperatur-Zyklus kann gestartet, ge-
stoppt und zurückgesetzt werden. Lieferumfang: 4 Auflageroste für ma-
ximal 16 Proben (max. 7 Roste und 28 Proben), elektronischer Regler,
Temperaturfühler.

6.1.2 Option Datenlogger

Die Option Datenlogger/Farbdisplay ermöglicht zusätzlich die Tempera-
turmessung im Kühlraum nach prEN 12390-9, 1339 und 1340. Der Reg-
ler kann über eine Ethernet-TCP/IP-Schnittstelle in jedes Intranet inte-
griert werden und ermöglicht so, zusätzlich zum eingebauten Display, ei-
ne Bedienung über einen beliebigen PC mit einem Internet Browser. Der
Temperatur-Verlauf der Probe, die Soll-Temperatur, die Ist-Temperatur
der Luft wird aufgezeichnet und kann von einem beliebigen Arbeitsplatz
direkt über einen Internet-Browser ausgelesen werden. Eigene Tempe-
raturverläufe können direkt am Gerät programmiert und auf 8 Speicher-
plätzen abgelegt werden.

Der Temperaturverlauf der letzten 24h wird grafisch am Display darge-
stellt.

Lieferumfang: TCP/IP-Schnittstelle, zusätzlicher Proben-Temperaturfühler,
Datenlogger-Software, Speicher-Modul, Bedienungsanleitung

6.1.3 Option Flutung

Die Option Flutung beinhaltet einen internen und einen externen Edel-
stahltank. Zeitgesteuert wird der innere Tank geflutet oder entleert. Das
Wasser im externen Tank, wird geheizt. Die Wassertemperatur ist ein-
stellbar. Diese Option setzt die Option Datenlogger voraus.

6.2 Sicherheitshinweise

• Um Unfälle, oder eine Beschädigung des Gerätes zu vermeiden
muss der Slabtester von 2 Personen ausgepackt werden.

• Trennen Sie den Slabtester vom Netz wenn ein Fehler auftritt.

• Alle Reparaturarbeiten dürfen nur von Schleibinger, oder einer von
Schleibinger beauftragten Person ausgeführt werden.

• Stellen Sie sich nicht in den Schrank, oder auf die Ablageroste.
Hängen Sie sich nicht an die Türe.

• Kinder dürfen nicht mit dem Slabtester spielen.

• Lagern Sie keine Lebensmittel oder Getränke im Slabtester !

• Lagern, oder verwenden Sie keine entzündlichen Chemikalien, Pro-
dukte oder Reinigungsmittel im Slabtester!

• Verwenden Sie die Flutungsoption, so ist der Heizstab des Außen-
behälters immer zu Fluten. Achtung die Heizung niemals berühren!
Verbrennungsgefahr! Heizung nicht an Kabeltrommel betreiben,
die Anschlussleistung beträgt 2,2 kW!

• Gerät nur an Steckdose mit Schutzleiter anschließen.
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6.3 Entsorgungshinweise

• Die Verpackung ist aus recyclebarem Material. Bitte entsorgen Sie
dieses Fach- und Umwelt gerecht.

• Lassen Sie, wenn jemals nötig, das Gerät fachgerecht entsorgen.
Schleibinger nimmt das Gerät gegen eine Aufwands-Entschädigung
zurück.

• Die technischen Daten des verwendeten Kältemittels finden sich
auf dem Typenschild.

6.4 Aufstellhinweise - Grundgerät

• Stellen Sie den Slabtester nicht im direkten Sonnenlicht, oder in
der nähe von Heizgeräten, Wärmeschränken oder ähnlichen Wärmequellen
auf.

• Stellen Sie das Gerät auf einem ebenen, Boden auf. Gleichen Sie
Unebenheiten mit den Einstellfüßen aus.

• Der Abstand zur Decke muss mindestens 30cm betragen! Stellen
Sie eine ausreichende Frischluftzufuhr sicher!

• Entfernen Sie die Schutzfolie vom Gerät, bevor Sie dies einschal-
ten.

6.5 Netzanschluss

Schließen Sie den Slabtester an eine Steckdose an die mit mind. 10A
abgesichert ist. Vergleichen Sie Ihre Netzspannung mit den Angaben
auf dem Typenschild. Die Steckdose sollte leicht zugänglich, und nicht
hinter dem Gerät sein.

Am Schuko-Stecker befindet sich ein DI Schutz-Schalter mit Auslöse-
Strom 30mA, allpolig abschaltend. Achten Sie darauf dass dieser einge-
schaltet ist. Wir empfehlen von Zeit zu Zeit, wenn keine Proben im Gerät
sind, die Funktion des DI Schalters durch Drücken der Prüftaste (kleine
Taste) zu überprüfen.

Vor der ersten Inbetriebnahme sollten Sie eine Stunde warten, und erst
dann den Slabtester mit dem Netz verbinden. Stellen Sie sicher dass die
Schutzerde ihrer Steckdose korrekt angeschlossen ist.

Der Slabtester selbst hat eine Leistungsaufnahme von maximal 1kW.
Die Option Fluten hat eine zusätzliche Leistungsaufnahme von 2,2 kW.
Betreiben Sie den Slabtester und die Option Fluten an 2 getrennt abge-
sicherten Steckdosen!

6.6 Aufstellhinweise für die Flutungsoption

• Verwenden Sie die Flutungsoption, so stellen Sie den Behälter
ebenerdig neben den Slabtester.

• Stellen Sie die Pumpe auf das Pumpentrageblech (Abbildung 4)

• Verbinden Sie die Pumpe mit dem Wasserdurchlass im Behälter

• Verbinden Sie den Wasserdurchlass mit dem Motorventil (Abbil-
dung 5 an der Rückseite des Gerätes

• Schließen Sie den Ablasshahn des Behälters
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Abbildung 4: Die Pumpe im Außenbehälter

• Verbinden Sie das Pumpenanschlusskabel mit der Powercon-Buchse
(grau und rund) an der Rückseite des Slabtesters. Dazu Stecker
einstecken und ca. 30◦ nach rechts drehen. Zum Entriegeln, die
Metalllasche auf dem Stecker nach hinten ziehen, und den Ste-
cker ca. 30◦ nach links drehen (Abbildung 7).

• Verbinden Sie das Motorventil mit der schwarzen Buchse an der
Rückseite des Slabtesters. Nach dem Einstecken den orangen Si-
cherungsring ca. 90◦ nach rechts drehen.

• Schalten Sie den Netzschalter aus, um sicher zu stellen, dass das
Motorventil geschlossen ist.

• Befüllen Sie den Behälter im inneren des Slabtesters mit der gewünschten
Wassermenge.

• Schalten Sie den Slabtester ein. Gehen Sie in das Menü Fluten
(Abb. 9) im Hauptmenü. Das Motorventil muss öffnen. Wählen Sie
dort den Punkt leeren. Das Wasser fließt vom Behälter im Slabtes-
ter in den Außenbehälter.

• Kontrollieren Sie ob der Heizstab im Außenbehälter ausreichend
mit Wasser bedeckt ist.

• Stellen Sie die gewünschte Temperatur am Einstellring der Hei-
zung ein (Abbildung 8). Die gewünschte Temperatur ist die Zahl
die oben steht.

• Frühestens jetzt den Heizstab mit dem Netz verbinden.

6.6.1 Türanschlag wechseln

Bei Bedarf kann die Türe links statt rechts angeschlagen werden. Abbil-
dung 10 zeigt die Details.

• Tür ca. 90◦ öffnen
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Abbildung 5: Das Motorventil an der Rückseite des Slabtesters

Abbildung 6: Anschluss für die Pumpe an der Rückseite des Slabtesters

Abbildung 7: Anschlüsse für das Motorventil und für das Netzwerk an
der Rückseite des Slabtesters
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Abbildung 8: Einstellung der Heizpatrone hinten am Außenbehälter

Abbildung 9: Menü um die Flut- und Leerzeiten einzustellen. Handbe-
trieb f. Fluten und Leeren

• Scharnierwinkel (1) abschrauben (Tür evtl. unterlegen)

• Tür nach unten abnehmen

• Oberen Scharnierwinkel (2) abschrauben. und auf der Gegenseite
wieder anschrauben.

• Basis-Lagerwinkel (3) abschrauben und auf der Gegenseite wie-
der anschrauben.

• Kunststoff Lagerhülse (4) von Scharnierwinkel (1) abziehen und
auf den oberen Vierkantstift stecken.

• Tür um 180◦ drehen.

• Tür bei 90◦ Öffnungswinkel in oberen Vierkantstift einhängen (Tür
eventuell unterlegen).

• Scharnierwinkel (1) in unteres Türlager einsetzen und am Basisla-
gerwinkel (3) anschrauben.

6.7 USB-Stick

über dem Display befindet sich der Steckplatz für den mitgelieferten
USB-Stick. Der USB-Stick soll nicht mehr als 2 GByte Speicherplatz be-
sitzen. Verwenden Sie den mitgelieferten USB-Stick.

Den Stick nicht mit Gewalt einführen.
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Abbildung 10: Türanschlag wechseln
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Abbildung 11: Der Innenbehälter der Flutungsoption mit Referenzfühler

6.8 Bestücken der Anlage mit Proben

6.8.1 Normalbetrieb

Die Proben werden auf mitgelieferte Gitterroste gesetzt. Abhängig von
der Höhe, der Anzahl und dem Gewicht der Proben können Sie den
Abstand der Gitterroste in 43mm Schritten einstellen.

Verteilen Sie die Proben gleichmäßig auf alle Roste im Schrank. Bela-
den Sie den Schrank nicht über die Markierung an der Rückseite des
Kühlraumes. Dies ist wichtig um eine gleichmäßige Luftzirkulation, und
somit eine gleichmäßige Temperaturverteilung zu gewährleisten. Stellen
Sie keine Proben direkt auf den Schrankboden.

Auf Höhe des Zusatzlüfters keinen, oder nur einen kurzen Tragrost ver-
wenden!

6.8.2 Flutungsbetrieb

Für den Flutungsbetrieb wird ein Edelstahlbehälter in den Schrank ein-
gehängt und die Rohrleitung zum Motorventil an der Rückseite des Schran-
kes angeschlossen. In den Behälter werden Gitterroste eingelegt. Bestücken
Sie den Behälter mit Proben wie in der Norm vorgeschrieben (siehe Abb.
11). Schalten Sie den Slabtester aus, um sicher zu gehen, dass das Mo-
torventil geschlossen ist. Füllen Sie dann bis zum benötigten Pegelstand
Wasser ein. Schalten Sie den Slabtester wieder ein. Lassen Sie dann
im Menü Fluten das Wasser in den (leeren) Außenbehälter ab. Pum-
pen Sie dann das Wasser wieder in den Innenbehälter. Korrigieren Sie
den Wasserstand im Innenbehälter nochmals bis zum benötigten Pegel,
da immer etwas Restwasser im Außenbehälter bleibt, um ein Trocken-
laufen der Heizung zu verhindern. Ist der Behälter geflutet, so schaltet
die Temperaturregelung vom roten Temperaturfühler auf den grauen Zu-
satztemperaturfühler um. Es empfiehlt sich den grauen Fühler in der Luft
über dem Behälter zu platzieren.
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Abbildung 12: Der Zusatzlüfter

6.9 Der Zusatzlüfters

Um eine optimale Umwälzung zu gewährleisten ist ein (optional zwei)
Zusatzlüfter (24V= Betrieb) an die Prüfraumtür montiert. Der Lüfter schal-
tet ab wenn die Türe geöffnet wird. Auf der Höhe des Zusatzlüfters darfAchtung!
kein normal tiefer Probenrost eingeschoben werden! Verwenden Sie auf
der Höhe des Lüfters keinen Rost, oder einen Rost mit reduzierter Tiefe!

6.10 Der Probentemperaturfühlers

Der Probentemperaturfühler ist der Fühler mit dem roten Anschlusska-
bel. Ist der Prüfraum geflutet wird der Zusatztemperaturfühler (mit dem
grauen Kabel) als Referenzfühler für die Regelung verwendet. Dieser
sollte dann nicht eingetaucht sein.

6.11 Wartung

6.11.1 Abtauen

Der Slabtester taut automatisch ab. Das Tauwasser läuft in eine beheizte
Schale oben neben der Kältemaschine und verdampft von dort automa-
tisch.

6.11.2 Reinigung

• Schalten Sie vor der Reinigung den Slabtester aus.

• Ziehen Sie den Netzstecker

• Entfernen Sie die Gitterroste, die Führungsschienen und die Tra-
geschienen.

• Zum entfernen der Trageschienen müssen Sie zwei Schrauben
lösen.
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• Reinigen Sie den Innenraum mit Hand warmen Wasser und et-
was Haushaltsreiniger. Verwenden Sie keine Scheuermittel oder
Säurehaltigen Reiniger. Wir empfehlen Reinigungsmittel mit einem
neutralen pH-Wert.

• Achten Sie darauf, dass kein Reinigungsmittel in die Elektrik, oder
die Lüftungsgitter kommt.

• Trocknen Sie alle Teile anschließen mit einem Tuch.

• Verwenden Sie zum Reinigen nie einen Dampfstrahler oder Was-
serschlauch!

6.11.3 Reinigen des Staubfilters

Je nach Ausführung ist der Slabtester mit einem Staubfilter ausgestat-
tet. Staubablagerungen am Verflüssigter können die Kühlleistung des
Slabtesters beeinträchtigen. Der Filter sollte deshalb bei Bedarf gerei-
nigt werden. Der Filter ist von oben zu erreichen und befindet sich links
hinter dem Display. Ist kein Filter montiert, so sollte der Verflüssigter von
Zeit zu Zeit mit Druckluft von Staub gereinigt werden.

6.12 Fehlerbehebung

Sie können kleiner Fehler selbst beheben wenn Sie folgende Dinge
überprüfen:

6.12.1 Der Slabtester arbeitet nicht, das Display ist schwarz.

• Ist der Stecker eingesteckt?

• Hat der DI Schutz am Stecker ausgelöst?

• Ist die Sicherung in Ihrer Verteilung ok?

6.12.2 Der Slabtester arbeitet nicht, das Display ist weiß, Meldung LCP 56

über dem Display befindet sich der Steckplatz für die Compact-Flash
Karte. Ist diese richtig gesteckt? Die Seite mit der Herstelleraufschrift
muss nach unten zeigen. Karte nicht mit Gewalt stecken, oder entfernen.
Karte nie während des Betriebs ziehen.

Geräte ab 2013 haben keinen Steckplatz für Compact Flash Karten
mehr. Stattdessen befindet sich auf der internen Elektronik ein Steck-
platz für eine SD-Karte. Bitte kontaktieren Sie Schleibinger.

6.12.3 Die Heizung arbeitet nicht

• Hat die Temperatur-Sicherung ausgelöst ? (Bildschirmmeldung)

• Rufen Sie im Zweifelsfall bei Schleibinger an: +49 8086 94010

6.13 Ausschalten des Gerätes

Wenn Sie den Slabtester längere Zeit nicht benutzen, so schalten Sie
Ihn bitte aus, ziehen Sie den Netzstecker, und öffnen Sie die Türe einen
Spalt weit.



7 Installation des Intranet-Anschlusses 27

7 Installation des Intranet-Anschlusses

Der Slabtester wird mit einem integrierten Daten-Logger und Web-Server
(optional) geliefert. Der Daten-.Logger kann die Temperatur-Messdaten
autonom ohne PC bis zu 40 Wochen aufzeichnen. Die Messdaten wer-
den nicht flüchtig auf einem internen Speicher gesichert. Sowohl der
Logger als auch der Regler sind mit einer Netzwerkschnittstelle aus-
gestattet. So können Sie den Slabtester in ihr lokales Labornetzwerk
einbinden. Selbst ein weltweiter Zugriff ist bei entsprechender Netzwerk
Konfiguration möglich. Sie müssen auf Ihrem PC kein spezielles Pro-
gramm installieren. Starten Sie ihren Internet-Browser (MS Internet-Explorer,
Mozilla, Opera o.ä.), geben Sie die Adresse des Slabtesters ein, und
schon können Sie mit Ihrem Browser den Regler steuern, oder sich die
Messdaten herunter laden. Alternativ können Sie die Loggerdaten mit
einem CF Kartenleser, der im Lieferumfang enthalten ist am PC aus-
lesen. Sie können für diese Funktionen jeden PC ab Betriebssystem
Win95..XP..Windows 8, MacOS oder auch Linux verwenden. Als Netz-
werk verwenden wir Ethernet 100BaseT mit TCP/IP Protokoll. Wenn
Sie die Funktion zur grafischen Messdaten-Darstellung verwenden wol-
len, muss noch die Java Unterstützung (Java1.1.8 auch Virtual Machi-
ne genannt) installiert sein. Fragen Sie im Zweifelsfall Ihren System-
Betreuer. Der Datenlogger benötigt eine feste IP Adresse in Ihrem Netz-
werk. Wenn Sie die direkt auf den Slabtester zugreifen wollen verwen-
den Sie bitte ein sog. cross-wired Kabel zur Verbindung zu Ihrem PC.
Ihr PC benötigt eine Netzwerkkarte mit RJ45 Anschluss. Während des
Versuchs muss kein PC mitlaufen.

• Der Netzwerk-Anschluss ist an der Rückseite des Gerätes.

• Um den Slabtester in Ihr Intranet einzubinden, empfehlen wir die
Verwendung eines. sog. Switches.

• Der Slabtester braucht eine freie IP Adresse. Die Adresse im Aus-
lieferungszustand ist an der Rückseite des Gerätes, neben der
Netzwerkschnittstelle vermerkt.

• Verwenden Sie das mitgelieferte Programm Chiptool.exe um die
IP Adresse zu ändern, oder auf DHCP umzustellen.

Abbildung 13 zeigt die Netzwerk-Anbindung.
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Abbildung 13: Anschluss des Slabtesters an das Intra-Net
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8 Konfiguration der Netzwerkschnittstelle

Der Datenlogger, der Schleibinger Slabtester, die CDF Anlage und die
AKR-Truhe sind mit einem 100 BaseT Netzwerkinterface ausgestattet.
Er kann in ein lokales Intranet, oder auch weltweit in das Internet inte-
griert werden. Die Netzwerkkonfiguration kann mit dem Programm Chip-
tool vorgenommen werden (zu finden auf der mitgelieferten Produkt CD-
ROM; Unterverzeichnis Beck\_chiptool).

Werkseinstellungen:

Gerät: Datenlogger für Schüsselrinne

Kunde: Musterwerke, Neustadt

Serien Nr: 201312330

MAC-ID: 00:30:56:90:7D:CC

Hostname: Bdrain_201312330

[] IP-Adresse automatisch beziehen

[] Folgende IP-Adresse verwenden: IP-Adresse:....................

Subnetzmaske:..................

8.1 Wie man eine Netzwerkverbindung zwischen dem Gerät und einem PC herstellt

Die folgend beschriebene Methode 1 entspricht der Werkseinstellung
IP-Adresse automatisch beziehen. In die Adresszeile Ihres Browsers
geben Sie den Hostname ein (1) - siehe Werkseinstellungen.

8.1.1 Arbeiten mit einem frei wählbaren Server Namen

Der Anschluss des Gerätes in ein lokales Netzwerk mit integriertem
DHCP- und DNS-Server ist die einfachste und schnellste Methode.

• Verbinden Sie das Gerät mit ihrem lokalen Netzwerk (Switch) mit
dem mitgelieferten Netzwerkkabel und schalten Sie das Gerät ein.

• Geben Sie in der Adresszeile Ihres Browsers des Hostname ein.
Siehe Symbol 1 in der Bildschirmdastellung 14.

Ein DHCP-Server erteilt dem Datenlogger eine freie IP-Adresse und
über den vergebenen Hostname mittels DNS erreichen Sie den Daten-
logger, siehe Bild 14.

8.1.2 Arbeiten mit einer festen IP Adresse

Falls die Hostname-Methode/DNS-Server nicht funktioniert, können Sie
den Datenlogger über seine zugewiesene IP-Adresse erreichen. Die IP-
Adresse des Datenloggers können Sie selber mit dem oben erwähnten
Programm chiptool ermitteln. Jedes Gerät in einem Netzwerk ist über die
sogenannte IP Adresse ansprechbar. Dies ist eine 12 stellige Nummer,
ähnlich wie eine Telefonnummer.

Ihr Netzwerkadministrator muss nur dafür Sorge tragen, dass künftig der
Datenlogger immer die gleiche IP-Adresse von dem DHCP-Server be-
kommt. Ein DHCP Server funktioniert im Prinzip wie ein Telefonbuch.
Dort wird einer IP Adresse (Telefonnummer) ein Name (Hostname) zu-
gewiesen.

Falls kein Netzwerk vorhanden ist oder aber Sie dürfen in Ihr lokales
Netzwerk keine Messgeräte anschließen, kann man den Schleibinger
Datenlogger direkt mit einem PC verbinden z. B. mit einem älteren No-
tebook. Die meisten PCs sind so konfiguriert, dass sie ebenfalls eine
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Abbildung 14: Zugriff auf das Schleibinger Gerät mit einem Symboli-
schen Server- oder Hostname

Abbildung 15: Auslesne der IP Adresse des Schleibinger Gerätes mit
dem Programm chiptool

automatisch zugewiesene IP-Adresse von einem DHCP-Server bezie-
hen. Im Fall einer direkten Verbindung zwischen dem Datenlogger und
einem PC fehlt diesen beiden Teilnehmern der DHCP-Server. Man muss
bei beiden feste IP-Adressen verwenden.

8.2 Einstellen einer festen IP Adresse an ein Windows PC

Öffnen Sie am PC die Systemsteuerung → Netzwerkverbindungen →
LAN-Verbindung→ Eigenschaften und stellen Sie eine feste IP-Adresse
aus einem der sogenannten privaten Bereichen z.B. 192.168.1.1 und
eine Subnetzmaske 255.255.255.0 ein. Gateway muss nicht eingestellt
werden.

8.3 Einstellen einer festen IP Adresse am Schleibinger Gerät

Verbinden Sie den Datenlogger und den PC auf dem Sie soeben die
feste IP-Adresse eingestellt haben am besten mit einem Cross-Wired
Ethernetkabel (Cat5, RJ45), nicht mitgeliefert, und starten Sie dort das
Programm chiptool. Das Programm sucht nach dem Datenlogger und
falls der PC richtig konfiguriert ist und das richtige Verbindungskabel
verwendet wird, erscheint das Schleibinger Gerät im Fenster des Pro-
gramms. Klicken Sie mit der rechten Maustaste auf den Eintrag in dem
Fenster und wählen Sie IP-configuration. Ein kleines Fenster erscheint.
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Abbildung 16: Zugriff auf das Schleibinger Gerät mit einer festen IP
Adresse

Abbildung 17: Konfiguration am PC für eine direkte Verbindung zwischen
PC und Schleibinger Gerät
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Abbildung 18: Konfiguration des Schleibinger Gerätes für eine direkte
Verbindung zwischen PC und Gerät mit dem Hilfsprogramm chiptool

Deaktivieren Sie dort die Wahl Use DHCP Stellen Sie dort ebenfalls ei-
ne feste IP-Adresse aus dem gleichen privaten Bereich (aber andere
als auf dem PC) z.B. 192.168.1.2 und die gleiche Subnetzmaske ein.
Abschließend klicken Sie auf Config

Wenn sie jetzt die soeben eingestellte IP-Adresse des Datenloggers in
die Adresszeile des Browsers eingeben, sollte die Startseite des Schlei-
binger Gerätes erscheinen.

Bitte Fragen Sie Ihren Netzwerkadministrator, wie man am besten ein
Schleibinger Gerät in Ihre Netzwerkinfrastruktur integriert.
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Abbildung 19: Grundmenü, ohne Option Programmierschnittstelle / Da-
tenlogger

Abbildung 20: Grundmenü

9 Der Regler

9.1 Einschalten des Slabtesters

überprüfen Sie ob die Speicherkarte gesteckt ist. Schalten Sie das Gerät
am Hauptschalter an der großen Taste am Netzstecker ein. Nach ca. 20s
erscheint folgendes Bild am Touchscreen. (19).

Alle Funktionen werden über den farbigen, berührungssensitiven Bild-
schirm (Touchscreen) gesteuert. Dieser funktioniert gleichzeitig als An-
zeige und Tastatur. Verwenden Sie für den Touchscreen keinen Schrau-
benzieher, Kugelschreiber oder sonstigen scharfkantigen Gegenstand.
Verwenden Sie die Finger oder einen speziellen Touchscreen-Stift.

9.2 Das Grundmenü

Auf dem nächsten Bildschirm sehen sie die 4 bzw. 5 Grundfunktionen
des Slabtesters. (22)

Taste Funktion
Start Startet den Frost-Tau Zyklus
Status Zeigt die Werte aller Temperaturfühler, die Zeit, und

den Zustand der Schutzschalter
Zykluszeit Setzt die Aktuelle Zeit des Frost Tau Zyklus, sowie

die Zyklen-Nummer.
Data→ USB Temperaturmessdaten auf einen USB Stick kopie-

ren (nur bei Option Datenlogger).
Einstellungen Alle anderen Einstellungen
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Abbildung 21: Grafisches Profilanzeige

Abbildung 22: Eingabe der Zykluszeit

9.3 Start

Wenn alle Einstellungen stimmen, so können Sie den Slabtester hier
starten. Es erscheint die Onlineanzeige. Nach einigen Sekunden star-
tet die Kälteanlage. Um die Anlage anzuhalten, drücken Sie auf eine
beliebige Stelle am Display. Es erscheint ein Menü wo Sie den Stopp-
Vorgang bestätigen oder abbrechen können.

9.4 Zykluszeit

Der Slabtester hat 8 frei programmierbare Temperatur-Programme, so
genannte Profile. Jedes Profil besteht aus mehreren Stützstellen. Jedes
Profil selbst kann n mal wiederholt werden.Hinweis!

Der Temperaturverlauf ist stark von der Beladung der Truhe, der Proben-
form und der Luftumwälzung abhängig. Der Sollzyklus beim Slabtester
muss deshalb an diese Parameter angepasst werden!

Das Standardprofil für den Slabtest (siehe Abb. 21 oder 3) dauert 24
Stunden. Es startet bei +20◦C fährt in 12h auf -20◦C und bleibt dort 4
Stunden lang. Innerhalb von 8 Stunden fährt der Slabtester wieder auf
+20◦C hoch. Wenn Sie die Zykluszeit verändern, verändern Sie indirekt
die Soll-Temperatur. Wenn Sie zum Beispiel die Zykluszeit auf 0h set-
zen, so beträgt die Soll-Temperatur +20◦C. Wenn Sie die Zykluszeit auf
z.B. 10h setzen, so ist die Soll-Temperatur -20◦C.

Die aktuelle Zykluszeit wird auf der ersten Taste dargestellt. Die Zyklus-
Anzahl auf der zweiten Taste. Wenn Sie die Zeiteingabe drücken, er-
scheint eine Zehner-Tastatur, mit der Sie die Zykluszeit eingeben können.
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Abbildung 23: Status-Menü

Abbildung 24: Schalteingänge

Der gültige Eingabe-Bereich liegt zwischen 0 und der definierten Zyklus-
Länge. Verwenden Sie die Rück-Taste (¡-) um ein Eingabezeichen zu
löschen. Verwenden Sie die große Entertaste um eine Eingabe zu bestätigen.

9.5 Status

Zu Wartungs- oder Kontrollzwecken können Sie sich hier alle Temperatur-
Werte und Schalteingänge anzeigen lassen.

Taste Funktion (Abb. 23)
Schalteingänge Zeigt alle Schalteingänge, wie Tür-Kontakt, oder

übertemperatur.
Temp/Druck Zeigt alle Temperatur-Werte
Grafik Zeigt kurz die Online-Grafik
Zurück zum letzten Menü

9.5.1 Schalteingänge

Hier (Abb. 24) wird der Zustand aller Schalteingänge dargestellt. Nor-
malerweise sollten alle Schalter geschlossen sein. Geöffnete Schalter
werden invers/grau dargestellt.

9.5.2 Temperaturen

Im nächsten Bild (25) sehen Sie die Temperaturanzeige.

Unterhalb der Temperaturen wird die Uhrzeit angezeigt. Die Taste Einle-
sen erneuert die Bildschirmdarstellung und liest die Werte neu ein.
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Abbildung 25: Temperatur-Status

Abbildung 26: Das Setup-Menü

Taste Funktion (Abb. 25)
T-soll Soll-Temperatur
T probe. Proben-Temperatur (rotes Kabel)
T luft. Lufttemperatur
T evap. Temperatur am Verdampfer der Kühlmaschine
T add. Temperatur des zusätzlichen Temperaturfühlers in

der Klimakammer (graues Kabel)
Zeit Uhrzeit
Einlesen Aktualisieren der Werte und der Anzeige
Zurück Zurück zum letzten Menü

9.6 Data→ USB

Hier können Sie die Messdaten, die intern aufgezeichnet werden auf
den mitgelieferten USB-Stick kopieren. Diese Funktion setzt die Opti-
on Datenlogger voraus. Ist diese Option nicht installiert, so wird dieser
Menüpunkt nicht angezeigt. Siehe Kapitel 10.

9.7 Setup

Der Schleibinger Reglers hat einen großen Vorteil: Sie können sehr ein-
fach und im Klartext alles konfigurieren, und so an Ihre Messaufgabe
anpassen. Die Meisten Einstellungen erfolgen im Setup-Menü (Abb. 26).
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Abbildung 27: Sollwert Vorgabe

Taste Funktion (Abb. 26)
Sollwert Hier können Sie vorgeben ob ein fester Sollwert, ein

Sollwert-Profil, oder ein externer Sollwert (UDP Pro-
tokoll) verwendet wird

Profileing. Eingabe, Auswahl, ändern und Anzeigen der Profile
Anzeige Einstellung des Touchscreens und der Online-Grafik
Kühlung Bitte nicht ändern! Einstellung Aggregat
Uhrzeit Einstellen der Uhrzeit
Fluten (optional) Hier werden Grundeinstellungen zum Fluten- und

Leeren vorgenommen. Die Flutzeiten werden in den
Profilen definiert s.o..

System System Menü - Einstellungen bitte erst nach
Rücksprache mit Schleibinger ändern

Zurück Zurück zum letzten Menü

9.7.1 Sollwert

Taste Funktion (Abb. 27)
Thermoelement Sollwert wird durch ein externes Thermoelement

vorgegeben (Option)
Festwert Ein konstanter Sollwert kann vorgegeben werden
Profil X Der Sollwert wird aus der Zykluszeit und dem aktu-

ellen Profil errechnet
Logger Sollwertvorgabe über Internet (UDP Port 6000)
Zurück zum letzten Menü

9.7.2 Profileingabe

Hier können Sie Ihr Profil auswählen (Abb. 28) . Profil 1..9 können am
Touchscreen oder über den WEB browser eingegeben werden.

Bitte wählen Sie eines der Profile aus. Wenn Sie das Menü verlassen
wird dieses Profil zum aktuellen Profil. Wenn Sie das Profil ändern wol-
len gehen Sie auf Eingabe.

Im Menü-Titel sehen Sie das ausgewählte Profil. Anzeige zeigt das Profil
als Tabelle . Erste Spalte : Zeit /h , 2. Spalte: Temperatur in ◦C (Abb. 29).

Das Profil ist in 5 Zeilen definiert. Es hat 99 Zyklen. Das bedeutet, der
Slabtester fährt dieses Profil mit einer Länge von 24 Stunden 99mal ab.
Nach dem letzten Durchlauf werden konstant 20◦C gehalten. Wenn Sie
einen endlosen Ablauf wollen so geben Sie als Zyklenzahl 32000 ein
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Abbildung 28: Profilauswahl

Abbildung 29: Profil-Eingabe Menü

Abbildung 30: Profilanzeige
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Abbildung 31: Grafisches Profilanzeige
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Abbildung 32: Ein weiteres Beispiel für die Temperaturprofileingabe

(das sind etwa 87 Jahre). Das nächste Bild zeigt das definierte Profil
(Abb. 31) als Grafik (Abb. 30). Sie können jedem Profil eine Minimal-
temperatur zuordnen. Der Slabtester versucht diese Minimaltemperatur
in der Luft des Kühlraumes nicht zu unterschreiten. Wählen Sie eine
Temperatur von -50◦C wenn Sie die Minimaltemperatur nicht verwenden
möchten.

Ein weiteres Beispiel für die Profileingabe sehen Sie in Abbildung 32.
Einzugeben ist die Zeilenzahl 5, und das Profil wie folgt:

Zeile Zeit / h Temperatur / ◦C
1 0,0 16,0
2 4,0 -14,0
3 7,0 -14,0
4 8,0 16,0
5 11,0 16,0

Flutungszeit Wenn die Option Fluten (siehe 6.1.3 und 6.8.2) instal-
liert istmuss die Zeit für das Fluten und das Leeren des Wasserbehälters
definiert werden. Dies geschieht ebenfalls in der Menüeingabe. Ist die
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Abbildung 33: Anzeige Einstellungen

Abbildung 34: Einstellung der Grafikanzeige

Flutzeit und die Leerzeit = 0 wird der Innenbehälter nicht geflutet. Ist die
Flutungsoption nicht installiert, ist die Eingabe ohne Bedeutung.

9.7.3 Anzeige

Hier (Abb.. 33) wird das Touchscreen kalibriert, sowie die grafische Online-
Darstellung eingestellt.

Taste Funktion (Abb.. 33)
Heller Hintergrundbeleuchtung heller
Dunkler Hintergrundbeleuchtung dunkler
Kalibrierung Kalibriert die Lage der Tastenfelder am Touchscreen

(nur f. Geräte vor 2004)
Grafikanzeige Alle Einstellungen für die Online-Grafik, wie Aus-

schnitt etc.
Onlineanzeige Art der Onlineanzeige: Text, Grafik oder keine
Zurück zum letzten Menü

Stellen Sie die Hintergrundbeleuchtung nicht heller als notwendig, dies
verlängert die Lebensdauer des Displays.

Grafikanzeige Sie können die grafische Onlineanzeige fast vollständig
selbst konfigurieren.
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Abbildung 35: Auswahl der Art der Onlineanzeige

Taste Funktion(Abb.34)
t ber.h Breite der Grafik in Stunden
t ras Gitterabstand der x-Achse in Stunden
t ber.◦C Höhe der Grafik in +/.◦C. 25 bedeutet von -25◦C bis

+25◦C
t ras Gitterabstand der y-Achse in ◦C
Interv.. Nach interv Sekunden wird ein neuer Bildpunkt ge-

zeichnet
x0 x-Position der Online-Grafik in Pixeln. Das Display

hat 320x234Pixel. Der Ursprung ist links oben
y0 y-Position der Online-Grafik in Pixeln.
Breite Breite der Grafik in Pixeln.
Höhe Höhe der Grafik in Pixeln.
Zurück zum letzten Menü

Wir empfehlen hier nicht unnötig viel zu ändern. Anzupassen wäre even-
tuell der Bereich.

Onlineanzeige Hier (Abb. 35) können Sie die gewünschte Art der On-
lineanzeige auswählen.

Taste Funktion (Abb. 35)
Grafik Eine Grafikanzeige der Temperaturdaten, ähnlich

wie bei einem Schreiber
Text Anzeige der Temperaturen und Zeiten in Text-Form
keine ein leerer Bildschirm
Zurück zum letzten Menü

Wir empfehlen die Grafikanzeige

9.7.4 Kühlung

Bitte hier nichts ändern!

9.7.5 Zeit

Der Slabtester hat eine eingebaute Uhr mit Datums-Funktion. Einstel-
lung erfolgt hier (Abb. 37). Die Uhrzeit sollte während eines Tests nicht
verändert werden, um keine inkonsistenten Messdaten zu erhalten. Die
Uhr wird von einer kleinen Lithium Batterie versorgt. Diese sollte alle
zwei Jahre gewechselt werden (Knopfzelle Renata 1220 oder kompati-
ble)
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Abbildung 36: Art der Kühlung

Abbildung 37: Uhrzeit stellen

Abbildung 38: Einstellungen für das Fluten- und Leeren
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9.7.6 Fluten (Option)

Mit der Option Fluten kann der Slabtester zu voreingestellten Zyklus-
zeiten geflutet oder geleert werden. Geben Sie die Flutzeiten bei der
Profileingabe wie in Kapitel 9.7.2 beschrieben ein. Die Zeitangaben be-
ziehen sich auf die gesamte Zykluszeit. Weiterhin kann hier der Innen-
behälter per Hand geflutet oder geleert werden. Die Wassertemperatur
des Außentanks wird direkt an der dort montierten Heizpatrone einge-
stellt.

Während das Wasser im Außentank elektrisch beheizt wird, kann das
Wasser im Innentank nicht geheizt werden. Um sicher zu stellen, dass
das Wasser im Innentank während des Tauens nicht zu kalt ist, oder zu
kalt wird, kann der Tank kurzzeitig , während der Flutungsphase gespült
werden. Dies erfolgt mit der Option Spülen. Hier wird eingestellt alle
wieviel Minuten der Tank gespült wird. Sinnvoll ist hier eine Einstellung
zwischen 10 und 50 Minuten. Eingaben kleiner 0 und größer 59 Minuten
werden verworfen.Wichtig!

Wenn der Tank geflutet ist, schaltet die Regelung vom Fühler mit dem
roten Kabel, auf den Zusatzfühler mit dem grauen Kabel um!

Taste Beispiel Einheit Funktion Abb. 38
Spülung 20 Minute Alle 20 Minuten wird der Tank in

der Flutungsphase kurz gespült
Leerdau. 120 Sekunden Der Ventil öffnet 120 Sekunden

damit der Tank leer läuft. Zeit-
bereich zwischen 0 und 600 Se-
kunden. Beim Test für Mauerzie-
gel ist das die Dauer, die das
Sprayrohr, nach dem sprayen
mit Druckluft entleert wird.

Test Fluten Der Tank wird manuell geflutet
läuft leer das Ablaufventil wird geöffnet.

Nochmaliges Drücken der Taste
schließt es wieder.

Test Leeren Das Ventil öffnet solange bis
die unter Leerdau. eingegebe-
nen Sekunden verstrichen sind,
um den Tank zu leeren

no
Fühlerumsch.

Normalerweise wird während
der Flutung der Isttemperatur
von dem Sensor mit rotem Ka-
bel auf den Sensor mit grauem
Kabel umgeschaltet. Ist dieser
Schalter aktiviert, wird der Sen-
sor nicht umgeschaltet.

Fluten /
Sprühen

Ist dieser Schalter gesetzt wird
geflutet, ansonsten wir gesprüht
(Option Test für Mauerwerk)

9.7.7 System Menü

Das Systemmenü (Abb. 39) ist durch einen PIN geschützt. Die PIN lautet
2603 !

Bitte benachrichtigen Sie Schleibinger wenn Sie in diesem Menü etwas
ändern möchten. Diese Menü ist primär für Service und Wartungszwe-
cke.
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Abbildung 39: System Menü

Ein Überblick über die wichtigsten Funktionen:

Taste Funktion (Abb. 39)
Hand Start und Stopp aller Funktion wie Kompressor etc.

bei Hand
Regler Regler-Einstellungen
Temp./Druck Test und Kalibrierung der Temperatursensoren
Ram-Reset Zurücksetzen aller Einstellungen auf Werks-Werte
DA kalib. Kalibrierung der analogen Ausgänge (Optional)
Diverses Wieder-Anlauf etc.
Abtauen Einstellungen zur automatischen Abtaufunktion. Sie

Kap. 9.7.7
Zurück zum letzten Menü

Systemmenü Hand In diesem Menü können sie die einzelnen Kom-
ponenten des Slabtesters ein- oder ausschalten. Dadurch lassen sich
die Komponenten einzeln auf Funktion prüfen.

• Lüfter Verda

Im oberen Teil der Anlage sitzt der Verdampfer. Dieser ist ein Wämetauscher
der durch die Kältemaschine (das Aggreagat) gekühlt wird. Am
Verdampfer sitzen 2 Ventilatoren, die warme Luft aus dem Prüfraum
ansaugen, durch den Verdampfer drücken, so dass kalte Luft in
den Kühlraum gelangt. Test der Lüfter: Schalten sie die Lüfter ein.
Aus dem im Prüfraum hinten sitzenden Auslass muss Luft kom-
men. Ein leises Lüftergeräusch sollte zu hören sein.

• Heizung

Schalten sie die Verdampferlüfter ein (s.o.) und schalten Sie die
Heizung ein. Nach einiger Zeit sollte warme Luft aus dem Auslass
im Prüfraum kommen.

Im Verdampfer sitzt zusätzlich eine Elektroheizung. Beim Auftau-
en wird der Verdampfer nicht gekühlt sondern geheizt. Wenn die
Heizung an ist, müssen auch die Lüfter im Verdampfer an sein.

• Aggregat

Die eigentliche Kältemaschine. Wenn diese Maschine an ist, muss
auch der Lüfter am Verflüssiger an sein.

Schalten sie die Verdampfer Lüfter, das Aggregat, den Lüfter am
Verflüssiger ein. Nach einiger Zeit sollte kalte Luft aus dem Auslass
im Prüfraum kommen.
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Abbildung 40: Setup Diverses

• Abtauen

Momentan ohne Funktion.

• Luft

Schaltet die Druckluft zum Freiblasen der Sprühdüsen für den Dach-
ziegeltest ein (optional).

• Lüfter Türe

Schaltet den Querstromlüfter in der Türe ein.

• Lüfter Verflüssiger

Schaltet den Lüfter am Verflüssiger neben dem Kälteaggregat ein.
Muss immer laufen, wenn das Kälteaggregat läuft.

• Pumpe

Schaltet die Tauchpumpe im externen Becken ein, um Wasser in
den Flutungstank im inneren zu pumpen. Darf nur laufen wenn das
Ventil offen ist. Beide Optionen nur vorhanden, wenn die Option
Flutung installiert ist.

• Motorventil

Öffnet das Motorventil um den inneren Tank zu fluten oder zu lee-
ren. Wenn die Funktion an ist, öffnet das Ventil. Im stromlosen
Zustand muss das Ventil geschlossen sein.

• Wasser

Öffnet das Magnetventil zum Besprühen der Dachziegel (optional).

Systemmenü Diverses
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Taste Funktion (Abb. 40)
Wiederanlauf wenn eingestellt, läuft der Slabtester nach einem

Stromausfall automatisch wieder an, Für diese
Funktion ist der DI Schalter am Netzkabel auf eige-
ne Gefahr durch einen Schuko-Stecker zu ersetzen.

Max.Temp xxx Maximal Temperatur im Slabtester. Nicht über
+40◦C einstellen - Brandgefahr!

Tastatursperre 100s nach dem Start wird der Touchscreen verrie-
gelt - aktiv bis Hauptschalter aus

Info→ USB Im Servicefall kann der interne Fehlerspeicher auf
den USB Stick kopiert werden. Stecken Sie vor-
her den mitgelieferten USB Stick ein. Warten Sie,
nachdem alle Dateien geschrieben wurden einige
Sekunden, bevor Sie den USB-Stick wieder entfer-
nen. Stecken Sie keine anderen Geräte wie Tastatu-
ren, externe Festplatten, Mobiltelefone o.ä. an diese
Buchse an!

Zurück zum letzten Menü

Systemmenü Abtauen Wie bei einem normalen Haushaltkühlschrank
kann es passieren dass der Wärmetauscher des Slabtesters mit der Zeit
vereist. Der Slabtester eerkennt dies automatisch wenn der Wärmetauscher
über längere Zeit sehr kalt ist. Der Wärmetauscher des Slabtesters wird
dann automatisch hochgeheizt, bis das Eis abgeschmolzen ist.

Der Abtauzyklus startet wenn die Min.Temp. in diesem Menü erreicht ist
und endet wenn die Max. Temp. erreicht wurde.

Wenn Sie ein zyklisches Frost-Tauwechsel Programm fahren wird der
Abtaumechanismus nicht benötigt. Schalten Sie die Min.Temp. dann auf
-50◦C, eine Temperatur die der Slabtester nie erreichen kann. Es findet
dann kein automatischer Enteisungprozess mehr statt.

10 Datentransfer mit dem USB Stick

über dem Farbdisplay sitzt ein USB Steckplatz. Dort kann der mitgelie-
ferte USB-Stick eingesteckt werden. Verwenden Sie keine anderen USB
Geräte, wie Drucker, MP3 Player, Tastaturen oder ähnliches!

Der Slabtester hat einen internen Speicher. Mit dem Menüpunkt Data
→ USB im Grundmenü, können die Temperaturmessdaten auf den USB
Stick überspiet werden. Hierzu ist die Option Datenlogger notwendig.
Außerdem kann im Servicefall der interne Fehlerspeicher ausgelesen
und auf den USB-Stick kopiert werden. Sie dazu Kapitel 9.7.7.

10.1 Einige Hinweise zum USB Anschluss

• Verwenden Sie nur die von Schleibinger gelieferten USB-Sticks

• Verwenden Sie niemals Gewalt, der USB-Stick muss sich stets
leicht stecken lassen.

• Den USB-Stick nie mit Flüssigkeit oder Druckluft reinigen.

• Den USB Stick niemals an Ihrem Windows PC formatieren.
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10.2 Auslesen der Messdaten

Mit dem Menüpunkt Data→ USB im Grundmenü, können die Tempera-
turmessdaten auf den USB Stick überspiet werden. Hierzu ist die Option
Programmiertool / Datenlogger notwendig. Auf dem USB-Stick befinden
sich dann Temperaturmessdaten im Verzeichnis /daten. Die Messdaten
befinden sich in einer Text Datei mit dem Namen:

\daten\data1.txt
Kopieren Sie diese Datei vom USB-Stick auf Ihren PC. Auf dem von
Schleibinger gelieferten USB-Stick, befindet sich auch eine Software
um die Daten grafisch darzustellen. Klicken Sie zum Start auf die Datei
index.htm im Wurzelverzeichnis des USB-Sticks oder öffnen Sie diese
Datei mit Ihrem Internetbrowser. Die Benutzeroberfläche ist angelehnt
an die Bedienung des Slabtesters über die Netzwerkschnittstelle. Siehe
Kapitel 11

10.3 Einlesen der Daten in Excel

Öffnen Sie die Datei data1.txt im Programm Excel. Es erscheint der
Dialog zum Datei-Import. Die Daten sind mit Tabulatorzeichen getrennt.
Die erste Spalte enthält die Sekunden seit dem 01.01.1980, die zweite
Spalte die Sekunden im Zyklus. Wenn Sie die dritte Datenspalte als Da-
tum/Uhrzeit formatieren erhalten Sie die entsprechenden Daten in Ihrer
Excel-Tabelle.

Die Bedeutung der weiteren Spalten ist:

T Soll, T Probe, T Luft, T Verdampfer, T Zusatz1, T Zusatz2

11 Software Bedienung über den Web-Browser

Der Schleibinger Slabtester kann weitgehend über sein eingebautes Netz-
werkinterface gesteuert werden. Die Benutzeroberfläche am PC ist ihre
Web-Browser Software. Geben Sie im Adressfeld ihres Browsers die IP
Adresse des Slabtesters z.B. 192.168.1.41 ein.

In Ihrem Browserfenster wird der folgende Startbildschirm erscheinen:
(Abb.: 41).

Durch Auswahl einer Fahne wählen Sie die Sprache. Nun sehen Sie ein
grafisches Menü wo Sie ihr Gerät (Slabtester, CDF-Anlage, oder Reife-
Simulator) auswählen können. Siehe Abb.: 42.

Nach der Geräteauswahl kommen Sie in das Hauptmenü. In der Kopfzei-
le können Sie den Messkanal auswählen. Abhängig von den installierten
Optionen kann dies im Einzelfall abweichen. In der linken Spalte (Abb:
43) sehen Sie das Kontroll-Menü

Sobald die Sie den Slabtester starten, startet auch die Datenerfassung
(Abb: 44)

Im Menüpunkt Daten-Reset werden alle Messdaten gelöscht. (Abb.: 45
)

11.1 Download der Messdaten

Die Messdaten werden lokal im Slabtester, auf der CF Karte über dem
Display gespeichert. Pro Kanal werden maximal 1,8 MByte abgelegt.

Der einfachste Weg um diese Daten in Ihren PC zu bekommen ist der
Web-Browser.
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Abbildung 41: Startbildschirm

Abbildung 42: Geräteauswahl
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Abbildung 43: Hauptmenü

Abbildung 44: Anzeige der aktuellen Messwerte numerisch
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Abbildung 45: Daten löschen

11.1.1 Daten - Text

Gehen Sie auf : Daten - Text. Im rechten Browserfenster werden nun
alle Daten angezeigt (Abb. 46). In der ersten Spalte die Sekunden seit
dem 01.01.1980, in der zweiten Spalte sehen Sie die Zykluszeit in Se-
kunden. In der dritten Spalte sehen Sie das Datums/Zeit-Format von
Excel. Wenn Sie diese Spalte in ihrem Excel Arbeitsblatt als Datum/Zeit
formatieren erhalten Sie dort die korrekte Zeitangabe. Die Messwer-
te in den folgenden Spalten sind: Soll-Temperatur, Proben-Temperatur,
Luft-Temperatur, Verdampfer-Temperatur, Temperatur - Zusatzfühler1 ,
Temperatur-Zusatzfühler2 (optional). Alle Spalten sind durch das Zei-
chen Tab (=Tabulator) getrennt.

Von diesem Fenster können Sie die Daten direkt über die Zwischenab-
lage in Ihr Excel, Word o.ä. kopieren.

11.1.2 Einlesen der Daten in Excel

Sie können aber auch im Datei-Laden-Menü von Excel direkt die Daten
aufrufen. Statt eines Dateinamens geben Sie:

http://192.168.1.40/DATEN/DATA1.TXT

ein die Daten werden dann direkt in Ihr Excelarbeitsblatt geladen. Wenn
OpenOffice oder StarOffice verwenden gehen Sie wie folgt vor.

Datei - Neu - Tabellendokument, dann

Einfügen - Tabelle - Aus Datei erstellen - Durchsuchen

geben Sie dann als Dateinamen

http://192.168.1.40/DATEN/DATA1.TXT
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Abbildung 46: Messwerte als Text-Tabelle

ein. Wenn Sie eine andere IP Adresse für den Slabtester verwenden
müssen Sie natürlich diese verwenden.

11.1.3 FTP

Der geübte Anwender kann die Daten auch mit FTP (FileTransferPro-
tokoll) auslesen. Log-in Name ist ftp, User-Name ist auch ftp. Die Da-
ten sind im Verzeichnis /http/htdocs/daten. Verwenden Sie hierzu nicht
den Internet-Explorer. Dieser verhält sich bei ftp nicht Norm gemäß. Wir
empfehlen Programme wie Wise-FTP oder smartftp.

11.1.4 Daten Logdatei

Hier werden alle wichtigen Vorgänge am Slabtester aufgezeichnet. Zum
Beispiel der Start oder der Stopp der Anlage, Fehlermeldungen und
ähnliches.

11.2 System Einstellungen

Die Konfigurationsdaten werden dargestellt.

11.3 Online-Grafik

Um die Temperaturdaten im Web-Browser grafisch darzustellen wird ein
sog. Java -Applet verwendet. Stellen Sie sicher, dass in Ihrer Software,
Java oder bei Microsoft die Virtuelle Maschine aktiviert sind. Dies ist
aber im allgemeinen vor eingestellt. Abbildung 47 zeigt ein Beispiel.

Sie können mehrere Temperatur-Kanäle gleichzeitig darstellen. Im nächsten
Kapitel sind die Möglichkeiten dieses Javaplot genannten Programmteils
genauer erläutert.
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Abbildung 47: Grafische Anzeige der Messkurven

11.4 Profileingabe im Browser

Sie können die Temperatursollwertprofile auch bequem mit dem Internet-
Browser eingeben. Dazu muss an ihrem PC die Option Java aktiviert
sein (fragen sie ihren Systembetreuer). Wenn Sie in der linken Menüleiste
Profile Eingabe auswählen, so erscheint rechts eine Liste der Profile.
Wählen sie das gewünschte Profil durch klicken auf den Link aus. Es er-
scheint eine Eingabemaske (siehe 48). In den ersten Zeilen können Sie
die Anzahl der zu fahrenden Zyklen sowie die minimale Prüfraumtemperatur
eingeben. Außerdem den Namen des Profils, sowie den beginn und das
Ende der Flutung. Dann wird das Temperaturprofil eingegeben. Die Zeit
ist immer absolut anzugeben. Ist das Feld Zeit/min gleich Null so ist die
Zahl 0 auch einzugeben, ein leeres Feld wird nicht als Null interpretiert.
Beim klicken auf den rechten oberen Button Grafik Aktualisieren

wird das eingegebene Profil gezeichnet. Unterhalb der Tabelle finden
sie die Taste Speichern. Das neue Profil wird erst wirksam wenn sie den
Slabtester aus- und wieder einschalten, oder Einstellungen im System-
menü am Touchscreen des Slabtesters verändern.
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Abbildung 48: Eingabe und Anzeige der Temperaturprofile im Browser



12 Grafische Darstellung der Messdaten mit HTML5 54

12 Grafische Darstellung der Messdaten mit HTML5

Schleibinger bietet ihnen zwei Möglichkeiten Messwerte Grafisch darzu-
stellen. Die eine Möglichkeit basoert auf einem sogenannten Java Ap-
plet. Dazu muss in ihrem Browser ein sogenanntes Java Plugin instal-
liert sei. Die andere neuere Möglichkeit verwendet die Techniken von
HTML5. Dazu benötigen Sie einen aktuellen Browser.

12.1 Browser Auswahl

Leider sind die aktuellen Browser nicht untereinander kompatibel. Als
Browser werden offiziel unterstützt: Internet Explorer 9+, Firefox 2.x+,
Safari 3.0+, Opera 9.5+ oder Konqueror 4.x+. Das verwendete Softwa-
rewerkzeug nennt sich FLOT und steht unter der MIT Lizens. Leider gibt
es mit einigen Browsern insbesondere unter Windows7 64bit Probleme.
Wir empfehlen dringend den aktuellen Firefox 14.01 oder höher.

12.1.1 Firefox

Die Grafik scheint aktuell ohne Probleme mit dem Firefox 2.x+ unter
Windows XP und Windows7 zu laufen. Ebenfalls unter Linux.

12.1.2 Opera

Beim Opera gehen sie bitte wie folgt vor: Geben Sie in die Adresszeile

about:config

ein.

Es erscheint dann eine Seite mit sehr vielen Einstellungen

Gehen Sie auf den Button

UserPrefs

In diesem Untermenü gibt es wiederum einen Eintrag;:

Allow File XMLHttpRequest

setzen Sie dort ein Häckchen.

Gehen Sie nach unten auf Speichern und starten Sie den Opera Brow-
ser neu.

Sollte die Grafik trotzdem nicht gehen, sagen sie uns bitte Bescheid. Sie
bekommen dann neue Software zu gemailt.

12.1.3 MS Internetexplorer

Der Internetexplorer 6.0 zeigt die Grafik nicht an. Der Internetexplorer
8.0 nach einigen Rückfragen, ob das Skript weiter laufen soll. Der Inter-
netexplorer 9.x unter Window7 Professional 64bit funktioniert nicht.

12.1.4 Google Chrome

Funktioniert unter Windows7 64bit nicht.
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Abbildung 49: Messkurvendarstellung im Internet-Browser

12.2 Bedienung von FLOT

12.3 Auswahl der Messkanäle

Im oberen Bereich befinden sich Schaltflächen mit denen sie die an-
gezeigten Kanäle auswählen können. Die Farbe der Messkurven ent-
spricht den Farben der Kanalnamen. Nach der Auswahl eines Messka-
nals müssen Sie auf das Icon mit den beiden grünen Pfeilen drücken um
die Daten neu zu laden.

12.4 Messbereichsauswahl in Y-Richtung

FLOT versucht einen optimalen Ausschnit für ihre Messdaten auszuwählen.
Durch Eingabe in den Feldern Temperatur min / max. könenn Sie den
Ausschnitt selbst auswählen.

12.5 Messbereichsauswahl auf der Zeitachse

Wenn Sie mit gedrückter linker Maustaste einen Bereich der Messung
überstreichen, wird ein Ausschnit auf der Zeitachse gewählt. Durch drücken
des Icons mit der Lupe oben rechts wird die Auswahl rückgängig ge-
macht.

12.6 Einfügen eines Textes

Wenn Sie das Icon mit der Büroklammer drücken öffnet sicch ein Text-
fenster in der Grafik. Hier können Sie Anmerkunegn eingeben. Das Kreuz
über dem Textfenster schließt es wieder.
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12.7 Drucken der Grafik

Firefox: Nutzen Sie die Druckfunktion des Browsers. Wählen Sie im
Druckdialog aktueller Frame um nur die Grafik ohne Menüs zu drucken.

Internet Explorer 9 und andere: Bei den meisten Browsern können Sie
durch drücken der rechten Maustaste in der Grafik einen Dialog öffnen
der das Drucken der Grafik alleine, ohne Menüs, erlaubt.
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13 Javaplot

Seit 2002 sind alle Baustofprüfsysteme der Fa. Schleibinger Internet
fähig. Das heißt, die Bedienung erfolgt nicht über ein spezielles Win-
dows Programm, sondern über jeden gängigen Internet-Browser. Dabei
versucht Schleibinger hier auf spezielle Dinge wie Flash zu verzichten
um das System von Win95 über Linux bis zu Windows XP, Vista Widows
7 und Windows 8 und MacOS kompatibel zu halten. Der im Internet noch
gängige Standard HTML4 hat allerdings eine große Schwäche, er kann
keine Vektor-Grafik darstellen. HTML5 fähige Browser sind allerdings
noch nicht überall installiert.

Aus diesem Grund hat Schleibinger für die CDF Prüfanlage, den Slab-
tester, die Schüsselrinne, den Schwindkegel, die Schwindrinne und zukünftige
Produkte ein Java Applet zur Messdaten-Darstellung entwickelt. Ein Ap-
plet ist ein Programm, dass der Web-Server (in diesem Fall das Mess-
gerät) an den Bedienrechner schickt, und das dort ausgeführt wird.

13.1 System-Voraussetzungen

Um ein Applet am Bedienrechner zu starten muss auf dem Bedienrech-
ner eine sogenannte JRE (Java Runtime Enviroment) oder im Microsoft
Sprachgebrauch eine VM (Virtual Machine) installiert sein. Die ist beim
Internet-Explorer von Win95 bis Win2000, sowie NT im allgemeinen au-
tomatisch geschehen, bei Windows XP und später kann dieser kosten-
los aus dem Internet nachinstalliert werden. Bitte beachten Sie dass die
VM im Internet-Explorer auch frei geschaltet ist. Außerdem sollte der
temporäre Internet-Speicher auf mindestens 2 MByte eingestellt sein.
Ein Applet kann aus Sicherheitsgründen nicht direkt auf Daten auf Ih-
rem Bedienrechner zugreifen. Ebenso kann ein Applet nicht auf dem
Bedienrechner drucken. Um hochwertige Grafik Ausdrucke zu machen,
greift Javaplot auf das pdf (Portable Document Format) und den Acro-
bat Reader zurück. Dieser muss auf Ihrem Rechner installiert sein. Das
Programm kann kostenlos von der Fa. Adobe über das Internet bezogen
werden.

Neuere Programmversionen der Browser verlangen die Installation ei-
nes Java-Plugins. Dies kann ebenfalls kostenlos von der Web-Site der
Firma Sun geladen werden.

Da sehr viele Internet-Seiten von Java und pdf Gebrauch machen, sind
Java und pdf Unterstützung im Allgemeinen schon vor installiert. Fragen
Sie im Zweifelsfall Ihren System-Administrator.

Gehen Sie auf folgenden Link um zu testen ob java korekt installiert ist:
http://www.java.com/de/download/testjava.jsp

13.2 Programmstart

Die Programm Oberfläche eines Schleibinger Gerätes erhalten Sie wenn
Sie die entsprechende Internet-Adresse (z.B. 192.168.1.40) in Ihrem
Browser eingeben. Das Programm Javaplot wird durch anklicken eines
Links im Browser gestartet. Z.B. Anzeige Grafisch. Es erscheint dann
das Fenster in Bild 50.

Mit dem Programm werden auch gleich die aktuellen Messdaten gela-
den. Der erste Programmstart kann einige Sekunden dauern, insbeson-
dere mit dem Internet-Explorer von Microsoft. Jeder weitere Programm-
start geht dann deutlich schneller, da das Programm dann aus dem tem-

http://www.java.com/de/download/testjava.jsp
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Abbildung 50: Javaplot und Internet-Browser

porären Speicher (Cache) des Browsers und nicht mehr vom Messgerät
geladen wird.

13.3 Messkurvendarstellung

In den folgenden Kapiteln ist beschrieben wie Sie Messkurven auswählen
und darstellen können. Diese Einstellungen sind im allgemeinen nur ein-
mal notwendig. Ist die Darstellung konfiguriert, so kann Sie mit dem
Menüpunkt File->ConfigSave auf dem Messgerät abgelegt werden.
Durch Aufruf von File->ConfigLoad werde alle Einstellungen wieder-
hergestellt. Eventuell muss dann nur noch der Bildausschnitt neu fest-
gelegt werden.

13.3.1 Aktivieren von Messkanälen

Das Applet Javaplot kann Kurven aus bis zu 12 Messdateien gleichzeitig
darstellen. Die Messdateien bestehen aus bis zu 8 Spalten mit Zahlen-
reihen. Dezimaltrennzeichen ist das Komma! Wissenschaftliche Zahlen-
darstellung (5,02E+03) ist zulässig. Jede beliebige Spalte aus den 12
Dateien kann gegen jede beliebige andere Spalte aus einer gleichen
oder anderen Datei aufgetragen werden. Bis zu 4 Kurven können mo-
mentan gleichzeitig dargestellt werden.

Die Auswahl der Messkanäle (Abbildung 51) erfolgt im Menü Setup->Channels.
Wählen Sie die Messdateien aus sowie die zugehörigen Spalten die je-
weils auf x- und y Achse aufgetragen werden sollen. Die Messdatei-
en sind mit File1..12 numeriert. Bei der CDF Anlage und dem Slab-
tester steht nur eine Datei (File1) zur Verfügung. Hier ist in der ers-
ten Spalte die Zeit in Sekunden seit dem 1. Januar 1980 aufgetragen.
In den weiteren Spalten T soll, T bad, T speicher sowie in den weite-
ren Spalten die Temperaturen der zusätzlichen Temperaturfühler. Beim
Slabtester gilt folgendes: In der ersten Spalte die Sekunden seit dem
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Abbildung 51: Einschalten der Messkanäle

01.01.1980, in der zweiten Spalte sehen Sie die Zykluszeit in Sekun-
den. In der dritten Spalte sehen Sie das Datums/Zeit-Format von Excel.
Die Messwerte in den folgenden Spalten sind: Soll-Temperatur, Proben-
Temperatur, Verdampfer-Temperatur, Luft-Temperatur, Temperatur - Zu-
satzfühler. Beim Schwindkegel und der Schwindrinne werden die einzel-
nen Kanäle in getrennten Dateien abgelegt. File1 entspricht Kanal 1 etc.
Die Zeit ist hier in Sekunden seit Messung-Start abgelegt.

13.3.2 Skalierung

Die Skalierung der Messdaten in Sekunden seit 01.01.1980 kann even-
tuell zu unhandlichen Zahlen führen. Auch wird ein Schwinden gerne als
negative Zahl dargestellt etc. Manchmal soll vom Sollwert auch eine kon-
stante Zahl abgezogen werden. Dies geschieht im Menü Setup->Scaling.

Es erscheint für alle Kanäle eine Tabelle (Bild 52). Es kann getrennt für
die X- und Y-Achse eine Skalierung vorgenommen werden. Im einfachs-
ten Fall gehen Sie auf den Auswahl-Balken. Dort stehen Ihnen folgende
Möglichkeiten offen:

Eingabe Beschreibung
1:1 Die Daten werden unverändert ange-

zeigt
-10, -4, -2, -1, 2, 4, 10 Der Wert wird mit den angegebenen

Faktoren multipliziert
min, h, d, week Der Wert wird in min etc. umgerechnet
et, et+10 Die Sekunden seit dem 1.01.1970

(=epoch time) werden in ein Datum
der Form Tag. Monat.Jahr umgerech-
net. Bei et+10 wird vom Start-Datum
01.01.1980 ausgegangen.

Excel Die Excelzeit wird in Datum und Uhr-
zeit umgerechnet

Other verwendet die Umrechnungstabelle

Die Umrechnungstabelle erlaubt eine einfache lineare Skalierung es wer-
den jeweils 2 Rohwerte angegeben, denen 2 Zielwerte zugeordnet wer-
den. Ein Beispiel: Die Y-Werte sollen mit einem Offset von -10 versehen
werden, es soll also von allen Werten die Zahl 10 abgezogen werden.
Die Zahlen-Paare werden also z.B. so angegeben :

y0 y1
0 100
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Abbildung 52: Skalierung der Messdaten

Abbildung 53: Farbe, Symbole etc.

Y0 Y1
-10 90

y0=0, y1=100 -¿ Y0=-10, Y1=90. Die kleinen Werte y0 und y1 repräsentieren
jeweils die Orginalwerte, die Kapitele Y0 und Y1 die zugehörigen Ziel-
werte. Diese Funktion ist nur aktiviert wenn im Auswahl-Feld des Kanals
und der Achse other angewählt ist. Die Berechnung der Werte wird nur
beim Einlesen der Daten vorgenommen.

Wenn Sie in diesem Menü Werte verändern, ist anschließend eventuell
die Taste Reload im unteren Bildschirm-Bereich zu drücken.

13.3.3 Farbe, Symbole Strichbreite..

Jeder Messkurve kann Farbe etc. frei zugeordnet werden. Dies geschieht
in Setup->Symbols (Bild 53)

Eingabe Beschreibung
Color Farbe der Messkurve
Linestyle verschiedene Linien-Arten, wie durchgezogen ge-

punktet etc.
Linewidth Linienbreite
Symbol None: es werden keine Symbole angezeigt, ansons-

ten Dreieck Kreis etc.
S.Gap Abstand der Symbole in Messpunkten
SymbSize Größe der Symbole
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13.3.4 Achsbeschriftung

Die Achsbeschriftung kann unabhängig für beide Achsen eingestellt wer-
den. Die geschieht in den Menüpunkten x-Tick Labels bzw. y-Tick La-
bels. Vom Aufbau her sind beide Menüs gleich.

Eingabe Beschreibung
Axis label Beschriftung der Achse z.B. Zeit/min hier kann ein

freier Text eingegeben werden.
Major tick Space Abstand der beschrifteten Hauptachsenstriche in

physikalischen Einheiten. Wird dieser Abstand
zu eng gewählt, so dass sich die Beschriftun-
gen überlagern würden, so wird automatisch ein
größerer Abstand gewählt.

Minor tick space Abstand der nicht beschrifteten Achsenstriche
tick prec Anzahl der Nach-Kommastellen bei der Achsbe-

schriftung
Major tick size Länge der Hauptachsenstriche
Minor tick size Länge der Nebenachsenstriche
Grid Es werden entlang der Hauptachsenstriche Gitter-

Linien (gestrichelt) gezeichnet

13.3.5 Legende

Es kann jeder Messkurve eine Legende zugeordnet werden. Diese be-
steht aus einem Strich in Farbe und Linien-Stil wie für die Messkurve
gewählt sowie einem Text dazu. Einstellungen erfolgen in Setup->Legends

Eingabe Beschreibung
Legend Die Legende wird an/ausgeschaltet
Frame Die Legende wird schwarz umrahmt
Fill Der Legenden-Hintergrund wird weiß gefüllt
xpos Position der Legende auf dem Zeichen-Feld Einheit

0..1 0=ganz links, 1 = ganz rechts
ypos Position der Legende auf dem Zeichen-Feld Einheit

0..1, 0 ganz oben, 1 = ganz unten
length Länge des Legenden-Strichs
Text Text zur Legende, auch mehrzeilig
Color Farbe des Legenden-Textes
Size Schrift-Höhe des Textes in Punkten

13.3.6 Allgemeiner Text

Zusätzlich zur Überschrift und zu der Legende kann noch ein allgemei-
ner Text positioniert werden. Zu finden unter dem Menüpunkt Setup->Strings+Things

Eingabe Beschreibung
Text schaltet den Text an oder aus
Frame umgibt den Text mit einem schwarzen Rahmen
xpos Position des Textes Bereich 0..1 0=links, 1=rechts
ypos Position des Textes Bereich 0..1, 0=oben, 1=unten
color Farbe der Schrift
Letter-size Größe der Buchstaben in Punkten

13.3.7 Überschrift

Unter Setup->Titles können Sie zwei Überschriften eingeben.
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Eingabe Beschreibung
Title bzw Subtitle Überschrift 1 und 2
Size Schriftgröße
xpos Position der Überschrift Bereich 0..1 0=links,

1=rechts
ypos Position der Überschrift Bereich 0..1, 0=oben, 1=un-

ten

13.3.8 Lage der Grafik auf dem Zeichen-Hintergrund oder Papier

Unter Setup-> Viewport kann die Lage des Achsenkreuzes auf dem
Zeichen-Hintergrund eingegeben werden. Eingegeben wird ein Fenster
auf dem Zeichenblatt in das das Achsen-Kreuz gezeichnet wird.

Eingabe Beschreibung
Xmin Bereich 0..100, 0 = links, 100=rechts z.B. 15.0
Ymax Bereich 0..100, 0=links, 100 = rechts z,B. 85.0
Ymin Bereich 0..100, 0 = oben, 100=unten z.B. 15.0
Ymax Bereich 0..100, 0=oben, 100 = unten z.B. 85.0
PDF Landscape Der Ausdruck erfolgt im Quer-Format
PDF Portrait Der Ausdruck erfolgt im Hoch-Format

13.3.9 Ausschnitt

Sie haben fünf Möglichkeiten den Ausschnitt der Messwerte festzulegen.

Im Hauptfenster Auf der linken Seite des Haupt-Fensters befinden
sich 4 Eingabe Zeilen:

Eingabe Beschreibung
x-min Eingabe des minimalen x-Wertes in physikalischen

Einheiten
x-max Eingabe des maximalen x-Wertes in physikalischen

Einheiten
y-min : Eingabe des minimalen y-Wertes in physikalischen

Einheiten
y-max Eingabe des maximalen y-Wertes in physikalischen

Einheiten

Nach der Eingabe eines neuen Wertequadrupels müssen Sie eventu-
ell die Draw Taste im Hauptfenster drücken, um ein Neu-zeichnen aus-
zulösen.

Im Menü Völlig identisch zu der Eingabe im Hauptfenster ist die Ein-
gabe im Menü Setup->Worldscaling

Mit der Maus Sie können einen Ausschnitt auch grafisch Auswählen.
Wählen Sie mit der linken Maustaste im Zeichen-Fenster das neue linke
obere Eck, wählen Sie sodann das rechte untere Eck, gehen Sie dann
auf Draw. Es wird ein neuer Ausschnitt dargestellt. Die aktuellen Eck-
Punkte werden auch in die Eingabe-Zeilen im Hauptfenster eingetragen.
(Siehe Bild 54)
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Abbildung 54: Ausschnitts-Wahl mit der Maus

Auto-Skalierung Die Taste Autoscale im Hauptfenster aktiviert eine
automatische Ausschnitts Wahl. Das System berechnet die Extrem-Werte
der Messdaten, und versucht alle Messwerte darzustellen. Vorher muss
natürlich ein Kanal und eine Messdatei ausgewählt sein. Diese Funktion
ist auch über das Menü Setup-¿Autoscale zu erreichen. Hier ist auch
eine getrennte Auto-Skalierung für x- und y-Achse möglich.

Die Schieber Ist der gezeigte Ausschnitt kleiner als der Datenbereich
so können Sie mit den Schiebern unterhalb des Grafik-Fensters und
rechts davon durch die Grafik scrollen

13.4 Speichern und Laden der Einstellungen

Alle Einstellungen die Sie vornehmen incl. Ausschnitt, Überschriften etc.
werden im Menüpunkt File-¿ConfigSafe abgespeichert. Die Daten wer-
den auf dem Messgerät abgelegt, nicht auf dem Bedienrechner ! Dies
kann einige Sekunden dauern. Mit File->ConfigLoad werden die Ein-
stellungen wieder geladen.

13.5 Drucken

Einem Applet ist es prinzipiell nicht erlaubt auf einem fremden Rechner
zu drucken. Aus diesem Grund gehen wir hier einen kleinen aber fei-
nen Umweg. Wenn Sie Ihre Grafik ausdrucken wollen so gehen Sie bitte
auf File->MakePDF es wird auf dem Messgerät eine PDF Datei abge-
legt. Dies kann einige Sekunden dauern. Das Menü des Messgerätes
im Browser bietet Ihnen einen Link PDF-darstellen. Wenn Sie diesen
anwählen wird automatisch das Programm Acrobat Reader gestartet
und Ihre Grafik dargestellt (siehe Bild 55)

Über die Druckfunktion des Acrobat-Reader können Sie nun die Grafik
ausdrucken. Sie können die Grafik aber genauso über die Zwischen-
ablage z.B. in ein Word Dokument übernehmen, oder lokal auf Ihrem
Bedienrechner abspeichern. Die Grafik bleibt auch auf dem Messgerät
gespeichert. Solange bis Sie erneut die Funktion MakePDF aufrufen.
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Abbildung 55: Darstellung der Kurve im Acrobat Reader
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Die Funktion Print arbeitet nur wenn Javaplot nicht als Applet sondern
als Programm arbeitet. Dies ist momentan nicht i.A. nicht der Fall

13.6 Messdaten Laden

Sobald Javaplot startet werden die Messdaten geladen. Die Daten wer-
den dann lokal auf dem Bedienrechner zwischengespeichert. Die Taste
Reload im Hauptfenster lädt die Daten neu vom Messgerät. Dadurch
wird die Anzeige aktualisiert.
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